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ABSTRACT

The work reported in this dissertation is the result of a joint venture of biomedical
scientists and engineers for understanding human middle ear mechanics through finite
element modeling and analysis. The main objective of the research is to explore the
middle ear dynamics by using an accurate finite element model of the human middle ear.

The research started with developing a systematic and accurate geometric modeling
method that can be employed to reconstruct the middle ear from the histological sections
of a human temporal bone in the Computer-Aided Design (CAD) environment. Using the
method, a solid model of human middle ear was constructed which reveals excellent
accuracy in geometry.

Then a finite element model of the human middle ear was built by using the
geometry translated from the CAD model and the published material properties of the
middle ear system. The finite element model was finalized as the base-line finite element
model by adjusting physical parameters based on the stapes footplate displacements
obtained by laser Doppler interferometry measurements. Finally, the accuracy of the
base-line finite element model was verified by using four sets of published experimental
measurements. These verifications demonstrate that the base-line model constructed
using the geometric modeling method developed in this research is adequate in predicting

the dynamic behaviors of the middle ear. Therefore, it is appropriate to employ the finite

Xiv



clement model to simulate the middle ear frequency response characteristics, which are
the main concerns in the middle ear sound transmission study.

The base-line finite element model was employed for three preliminary clinical
applications. The results suggest that the base-line finite element model is very useful in
the study of the middle ear mechanics, and the design and test of implantable hearing

devices.

Xv



CHAPTER ONE

INTRODUCTION

Hearing loss is the second most widely spread impairment in the United States. More
than 24 million Americans have a hearing and speech impairment, and 3% of all children
are hearing impaired. Because of the rapid increase in the aged population, the number of
people with communication disorders is growing faster than the general population
[Silverstein eral. 1992, VMBHRC 2000]

Dramatic advances in medicine and technology have led to new surgical
reconstruction techniques and implantable hearing devices that allow physicians or
surgeons to help patients for rehabilitation. The further advancement of the techniques
and devices requires a better understanding of transfer characteristics of the ear where the
airborne sound is first transformed into mechanical vibrations of the ossicular chain, and
then to the fluid vibrations in the inner ear. However, the mechanics of hearing is not yet
fully understood, in spite of the considerable amount of research and publications. This is
why middle ear mechanics has gained a growing interest in both experiment and
modeling over the past years. It is a challenging task to gain more insights into the middle
ear mechanics. This task must be tackled by interdisciplinary collaboration of physicians

and engineers.



1.1 Middle Ear Modeling: History And Current Status

Attempts to provide an accurate mathematical model of the middle ear began with
the work of Helmholtz in 1869. Helmholtz suggested that the eardrum’s curvature was
the primary cause of the transformer ratio of the middle ear '™z 1871 Gince then, a
number of analysis methods have been attempted to explore the middle ear mechanics.
One of the main modeling methods is circuit analog analysis. The method provided many
insights and is still used widely in recent years !7Vilocki 1975: Kringlebotn 1988: Goode et al. 1954:
Rosowski 1996: Hudde & Weistenholer 1997] However, these circuit analog models are not suitable to
capture the actual stress field, detailed vibration modes, the influence of ultrastructural
modifications, as well as nonhomogeneous, anisotropic material properties of the middle
ear.

Some of these models, such as Onchi (O™ ¥ and Hudde er af, Mudde & Weistenhoter
71 actually employed multibody dynamics approach [Roberson & Schwertassck 1988] by ap
though the circuit analog part is taken away, the method still works by directly solving a
set of differential equations. Eiber’s model is another valuable muitibody model for
ossicles ™ 1991 his analysis, the eardrum was examined by finite element method.
Multibody dynamics approach is excellent in dealing with a system with rigid motion but
will experience difficulty while modeling a “flabby” body such as the eardrum.

Another main modeling method is the finite element method (FEM). FEM was
developed in 1960s as an approach for solving structural mechanics problems. With the

rapid advances of computer technology, FEM has been recognized as a powerful, general

numerical approximation method for any physical problems that can be formulated as



partial differential equations. FEM has been widely used to investigate biological systems

because of the following advantages:

(1) Itaccurately models the complicated irregular geometry of biological structures;

(2) It realistically models the non-homogenous, anisotropic mechanical properties of the
biological materials;

(3) Its various result-visualization methods, such as numerical, graphical and animated
ones, enable the result to be understood and interpreted easily and accurately.

The investigation on the FEM analysis of the middle ear mechanics has been
reported in many papers. Different finite element (FE) models have been used to simulate
the static or dynamic behaviors of the subsets of the middle ear or the entire middle ear.

The first FE model of the eardrum was presented by Funnell er al. in 1978. It was a
static three dimensional (3D) model of the cat [Fue! & Laslo 1978) Ty inertial effects were
later added to the model, and the natural frequencies and mode shapes were calculated
[Funncll 19831 The damping effects were not included in either of those two models. The
damping effects were added and the frequency responses of the cat eardrum were
compared with the experimental results in a later paper [Funell: Decraemer & Khanna 1987) -~ o
further improvement was completed by incorporating an elastic manubrium into the

model {Funnel. Khanna & Decraemer 1992) In this paper

it is worth mentioning that the manubrium
was reconstructed from serial histological sections. A set of histological sections of a cat
middle ear were used to reconstruct the geometry of the ossicles, the posterior incudal
ligament and the manubrium for the finite element model. However, no detailed

discussion was revealed to delineate how to generate the 3D surfaces by joining a set of

histological section contours and how to determine the relative spatial positions and



orientations among the middle ear components. Based on the model developed in 1987,
the mechanical coupling between the eardrum and the manubrium was studied Fum! 1991,
In these papers, the actions of the ossicular chain and cochlea on the eardrum were
represented as a single effective torsional stitfness and a moment of inertia at the “hinge”
of the manubrium. The model (developed in 1992) was also improved by adding explicit
representations of the ossicles and the cochlear load. The effects of two types of middle
ear surgeries were simulated using this improved cat middle ear mode] [Fd & Funnell 19%6]
The modeling method of Funnell et al. is simple but may not accurate due to the limited
geometric information. Their interests seemed to focus on the investigation of the
characteristics of cat middle ears.

Following the eardrum modeling procedure of Funnell er al. a FE model of the
eardrum was developed to build an eardrum rupture criterion by Stuhmiller {Suhmiller 1989}
Stuhmiller quantified the blast environment into different types of pressure histories and
successfully related the tensile stress responsible for injuries to various types of pressures
by static and dynamic response analyses.

William et al. began publishing their models in 1988. A two dimensional (2D) cross
sectional model, including eardrum and malleus, was created to examine the static
behavior of the human eardrum [Lesser & Williams 1988 ' 5 gifferent 2D cross sectional model
of the eardrum was developed to relate some diseases to the maximum shearing stress of
the eardrum [Lesser: Williams & Skinner 1988) A nyher 2D cross section model was employed to

investigate the stress and displacement levels in the reconstructed ossicular chain [Lesser.

Williams & Blayney 1911 The 2D cross sectional model revealed some of the static and dynamic

characteristics of the middle ear. However. these models are oversimplified.



The first 3D middle ear FE model of Williams et al. was published in 1990 to
examine the effect of several eardrum geometric and material parameters on the natural
frequencies of the eardrum Wiliams & Lesser 1990} pha oeometric modeling method is similar
to Funnell er al.’s, but the different element type and varying eardrum thickness were
employed in the FE model. Note that no ossicular loading was incorporated in the model.
The model was modified to investigate dynamic characteristics of the Fisch II spandrel
total ossicular replacement prosthesis [V1ams & Lesser 19921 The model was improved by
introducing beam elements connected at the nodes of shell elements in order to simulate
the radial and circumferential fibers of the eardrum’s ultrastructure. This model was

employed to examine the dynamic behaviors of the normal eardrum [Vilams & Lesser 19931 g

well as the mode shapes of damaged and repaired eardrums [Wiliams. Blayney & Lesser 1997) -ppy o
model was modified by adding solid elements to represent malleus and incus, and was
employed to investigate the dynamic behaviors of the reconstructed middle ear using two
different stapes replacement "illiams. Blayney & Lesser 19951 The modified model was later used
to examine the dynamic characteristics and the harmonic response of diseased, repaired
and reconstructed middle ear [Wiliams. Blayney & Rice 1996ab: Blayney. Williams & Rice 1997] Tpo
geometric modeling method of Williams et al. is very similar to Funnell et al.’s, which is
simple but inaccurate due to the insufficient geometric information. Values of some of
the physical parameters employed in their models seem unreasonable compared to the
published data. The main contributions of Williams er al. lie in the fact that their work
related the mechanics characteristics of the middle ear to the clinical applications.

The middle ear FE model of Wada et al. was published in 1992 (W24 Metoki & Kobayashi

"2 Their model included eardrum. ossicles and cochlear impedance: and it was



assumed a fixed rotational axis from the anterior process of malleus to the short process
of the incus. So the elasticity of the anterior mallear ligament and the posterior incudial
ligament was neglected. The mechanical properties and boundary conditions of the
middie ear were determined by comparing the numerical results obtained from the FE
analysis and those measured from fresh cadavers. The model was modified in their later
papers [Wada, Koike & Kobayashi 1996; Koike, Wada er al. 1996) to include middle ear Iigamems, middle
ear cavity (as a rectangular solid) and ear canal (as a rigid tube). The forced frequency
response to an acoustic excitation was performed. The model was also employed to
investigate the acoustic properties of some middle ear prostheses Ko/ Wada & Kobayashi 2000
An accurate geometric modeling method for the components of the human middle
ear was presented by Beer er i, (Beet ¢ al. 1996: Drescher. Schmidi & Hardtke 1998] 11y thig method, the
surfaces of the middle ear components including malleus, incus, stapes and eardrum were
measured by laser scanning microscopy, and then the geometric model for each middle
ear component was created based on the characteristic points measured. The FE models
of the middle ear obtained by this method were assembled into different sub-models to
investi gate their dynami ¢ characteristics [Beer et al. 1996: Drescher, Schmidt & Hardtke 1998: Beer et af. l999|.
The submodel of the eardrum with malleus and ligaments was also employed to conduct

parameter identification study (8o’ 1999

, and to examine the dynamic behavior of the
middle ear reconstructed by a special Bell prosthesis “"™™" ¢ ¢ 19%] The geometric
modeling method employed by Beer et al. is very accurate for each component. However,

although the scaling procedure was performed for assembly, the inconsistency between

different components was unavoidable because each component came from different



temporal bones. And it’s hard to keep these components in proper spatial positions and
orientations while assembling. They did not present a model of the entire middle ear.

A middle ear FE model created by Prendergast et al. was published in 1999 [Frendergast
Fertis et al 1991 The model is very similar to Wada er al.’s, both in geometry and in
mechanical properties. The important differences of Prendergast er al.’s model from
Wada et al.’s are: (1) The ear canal was modeled more accurately than Wada et al.’s. (2)
anisotropic and non-homogenous mechanical properties were used in eardrum, and (3)
the boundary conditions of the eardrum and the incudomallear joint were handled in a
way different from Wada er al.’s. The model was employed to examine the middle ear
dynamic characteristics, with and without a partial or total ossicular replacement F*™ &
Prendergast 20001 The model was also used to investigate the effect of the ventilation tubes on
stresses and vibration modes of the eardrum [Prendereast Kelly eral. 1959]

The models of Wada et al. and Prendergast ef al.’s were categorized as the detailed
analysis models with validations. But the predication may be impaired by their inaccurate
geometry, especially when the analysis results are not so satisfactory compared with
experimental results as presented in Prendergast et al.’s work.

It is well known that an accurate 3D geometric model of the human middle ear is the
crucial first step for developing a 3D FE model for middle ear mechanical analysis. A
review about the accurate geometric reconstruction of the ear is presented next. Besides
Funnell et al. and Beer et al. mentioned above, other authors who developed accurate ear
geometric reconstruction methods include Takagi er al., Fujiyoshi et al. and Weistenhofer
et al.. Although these methods were developed for other applications, for example, the

cochlear length measurement. they can also be used for finite element modeling. Takagi



and Sando’s method for studying the 3D structure of the temporal bone provided a wire
frame model of the cochlea [T & Sando 1989; Takahashi er al. 1989] yo the method, each
histological section of the temporal bone was projected onto a paper for magnification.
Then these papers with magnified images were stacked and aligned, and the outlines of
the structures were input into a computer by a digitizer. Obviously, the error induced in
this procedure was not trivial. Fujiyoshi et al. proposed a method for reconstructing the
temporal bone, which is similar to Takagi and Sando’s method except for the histological

section preparation [Fujiyoshi, Mogi et al. 1992]

. Fujiyoshi et al. employed a microscope
television camera for section digitization and 3D-reconstruction software for creating the
geometry of a monkey ear. These two methods seem to capture detailed geometric
information with some success. However, the models were not connected to commercial
CAD (Computer-Aided Design) software for the computer-integrated application.
Weistenhofer and Hudde presented a two-step procedure to create a geometric model of
human ossicles [Weisteahofer & Hudde 19991 -pre ogsicles’ silhouettes under different but well-
defined angles were projected on to paper using a special device and an overhead
projector. The silhouettes were captured by hand drawing on the paper and scanned into
computer. The solid geometric models of ossicles were then generated by extruding those
silhouettes in AutoCAD [Awodesk- Inc. 193] “This procedure may provide accurate geometry
for the ossicles. However, it is difficult to determine proper spatial positions and
orientations of each ossicles while assembling. Furthermore, it is almost impossible to
create geometry of the eardrum by using this procedure.

All authors mentioned above tried to develop an accurate model of the middle ear.

Their models are either geometric or FE. All existing models of the middle ear



contributed to the advancement of the middle ear mechanics in following aspects:
(1) Geometric reconstruction of the middle ear;

(2) Finite element modeling of the middle ear;

(3) Investigation and test of the middle ear material properties;

(4) Calibrations and verifications of finite element models of the middle ear;

(5) Clinical applications of finite element models of the middle ear.

However, no model is perfect. In addition, there is not a feasible computer-integrated
finite element modeling method to systematically combine all the aspects together.
Therefore, a simple, systematic and computer-integrated method is needed to help
researchers create accurate finite element models of the entire human middle ear,
including malleus, incus, stapes, eardrum, articulations and other suspensory ligaments
and muscles. And a better FE model of the middle ear is needed to predict the dynamic

behaviors of normal, diseased, and altered human middle ears.



1.2 Hypotheses And Objectives
As we know, all research is hypothesis driven. The hypotheses of this study are
formulated as follows:

(1) Finite element method can be used to predict the dynamic behaviors of normal,

diseased, and altered human middle ears;

(2) An accurate and systematic geometric modeling method can be developed to support

the human middle ear FE modeling;

(3) The FE middle ear model can be calibrated using experimental results to produce the

base-line FE model;

(4) Clinical applications can be characterized by identifying and quantifying FE model

parameters such as geometric characteristic parameters and material properties.
Based on the hypotheses formulated above, the objectives of this proposed research
are defined as follows:

(1) Understand middle ear mechanics by combining the FE structural frequency
response analysis and the Laser Doppler Interferometry (LDI) experimental
measurements.

(2) Develop a computer-integrated modeling method that supports engineers to convert
a set of histological sections into an accurate finite element model.

(3) Create a base-line middle ear finite element model that captures the structural
characteristics of human middle ear.

(4) Simulate the diseased or altered middle ear by varying parameters of the base-line

FE model, which link to realistic clinical applications.



1.3 Approaches

In this research, advanced computer-based modeling and simulating techniques,
namely, experiment- and computer-based imaging processes, Computer-Aided Design
(CAD) ™= "I and Computer-Aided Engineering (CAE) ¢ ! are employed to
reconstruct the geometry of human middle ear, and to explore the middle ear mechanics.
The whole research can be categorized into four parts: theoretical and FE modeling
preparations, geometric modeling, FE modeling and FE simulations, as shown in Figure
1.1. The theoretical and FE modeling preparation utilizes the finite element method and
structural vibration theory, describes the basic FE modeling procedure by creating a
simple model, and investigates the material properties of middle ear components and
attachments. This part will be discussed in Chapters 2 and 3. The second part, an
advanced geometric modeling method, will be introduced in Chapter 4. The FE modeling
will be discussed in Chapter 5 with the detailed considerations in the middle ear FE
modeling and the model verifications. Chapter 6 introduces some clinical applications of
the FE model, such as the stapes rocking study, the mass loading effect of implants and
the eardrum stiffness study. Chapter 7 gives the conclusions of the research and

recommendations for future work.
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Figure 1.1 Computer-integrated FE modeling and simulation of human middle ear



CHAPTER TWO

FUNDAMENTALS OF FINITE ELEMENT ANALYSIS

This chapter provides the basic concepts, basic theory and solution techniques of the
finite element method (FEM) for structural dynamic problems. The contents in this
chapter are the key for understanding how to convert the middle ear mechanical analysis
into a structural dynamic analysis, although some work described in this chapter can be
taken care of by ANSYS (545 1P Ine- 19%8al ' commercial FEM software that was employed
in the research. The contents in this chapter are also the key to correctly solving problems
using commercial software and interpreting resuits. The first two sections describe the
basic concepts and equations of finite element structural analysis (52200 & Babuska 19911 e
third section introduces a solution technique for structural dynamic problems. The fourth

. o . N . . atth 3 . p 2
section discusses damping expression in structural analysis (%" & Ferari 1999 Hart &Wong 2000}

The chapter closes with the descriptions of element types employed in this research 5P

Inc. 1998b)

2.1 Basic Concepts Of The Finite Element Method

The finite element method is a computer-based computation method that can be used
to analyze a field, which is defined as a physical quantity varying with position within the
object. There are many kinds of fields, and each field has a different influence on the

object’s performance. The fields are related to the potentials as their derivatives with
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respect to position. The exact form of the spatial derivative may vary with the type of
fields. In this research, the object is a structure like the middle ear system, so the
introduction to FEM is devoted to structural problems. For a structure, the field is stress
and the potential is displacement. In general, a structure serves to resist applied loads and
other influences. The theory requires discretization of a given structure into a network of
finite elements and implementation of the analysis on a digital computer. Advances in
computer hardware and software have made it easier and more efficient to use FEM for
solving complex structural problems.

A finite element (FE) is a subregion of a continuum. It is of finite size (not
infinitesimal) and usually has a simpler geometry than that of the continuum. The points
where the finite elements are interconnected are called nodes or nodal points, and the
procedure in selecting the nodes and forming finite elements is called discretization. FEM
enables us to convert a problem with an infinite number of degrees of freedom to one
with a finite number in order to simplify the solution process. FEM yields an approximate
solution based on an assumed displacement function, stress function, or a mixture of
them within each finite element, which are called shape functions. The assumption of
displacement functions is the most commonly used technique.

FEM begins with building a finite element model of a structure. The FE model is an
assembly of finite elements, which are obtained by discretizing the continuum. The finite
element model contains the following information about the structure:

e  Geometric domain, which is subdivided into finite elements;
e Material properties, which is assigned to each finite element;

e Loads, which are applied as exciting force;



Constraints, which are applied to prevent rigid body motion.

Material properties, loads, and constraints can often be expressed quickly and easily,

but geometry is usually difficult to describe for a complex structure. A typical structural

finite element analysis includes the following steps:

(M

()

(4)

©)

™

Discretize the structure. The structure is divided in to finite elements. Finite element

[Altair Computing Inc. 1997)

analysis (FEA) preprocessors, such as HyperMesh and Patran
[MacNeal-Schwendler Corporation 1998] Lol the user create the finite element meshes. This is
one of the most crucial steps in determining the solution accuracy of the problem.
Define the element properties. At this step, the user must define the element material
properties and select the types of finite elements that are the most suitable to model
the physical system.

Assemble the element mass, damping and stiffness matrices. The mass, damping and
stiffness matrices of any element can be derived from an energy method based on its
assumed shape function. They are then assembled to form the mass, damping and
stiffness matrices of the system. These matrices relate the nodal displacement,
velocity and acceleration to applied forces at the nodes.

Apply the loads. Externally applied concentrated or distributed forces. moments, and
ground motions are provided at this step.

Define boundary conditions. The support conditions must be provided, i.e., the nodal
displacements at some boundaries must be set to known values.

Solve the system of linear algebraic equations. The above steps lead to a system of

simultaneous algebraic equations where the nodal displacements are the unknowns.

Calculate stresses, reactions, natural modes or other pertinent information.
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2.2 Basic Equations Of The Finite Element Method

2.2.1 Basic Equations In Elasticity
For an elastic continuum under loads including body forces and boundary surface

loads, as shown in Figure 2.1 (a), the stress state at any point can be expressed by nine

(a) (b)
Figure 2.1 An elastic continuum and an infinitesimal element in its field
(The body forces, b, are not shown in the figure)

stress components with respect to a right-hand orthogonal coordinate system. The body
forces are denoted by b;, b, and b. that are the forces per unit volume in the respective x-,

y- and z-directions of the coordinate system and can be written in a vector form as
b=..b,.b.f @1

where the superscript “T” means the transpose of a vector or matrix. Figure 2.1 (b) shows

an infinitesimal element of the continuum at any given point in the Cartesian coordinates,
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with the edges of dx, dy and dz long. The normal and shear stresses are indicated by
arrows on the faces of the infinitesimal element. The normal stresses are labeled oy, oy,
and o, whereas the shear stresses are labeled tyy, Ty, Tz Tyx, Tz, and 1y, From
equilibrium of the element, we know

T.=T

Xy wr Ty
Therefore only six stress components are independent. Corresponding to stresses. the

deformation is expressed as normal and shear strains. Normal strains, €, €y, and €, , are

defined as

ov
&, o y 5' &, oz (2.3)
where u, v and w are displacements at the given point in the respective x-. y- and z-

directions. Shear strains, yyy, Yyz Yz« Yyos Yzy» and Yy, are defined as

I -
Y\_v ay Y}'X" ‘YVZ oz ay YZY' Y Oz Ox Vo (2.4)

&

Obviously, only three of the shear strains are independent. For convenience, the stresses,
strains and displacements are represented as vectors
6= {ox,cy,oz,txy,tyz,tl‘ ', oe= {ex,sy,sz,yw,yﬂ,yu Foou=fuv.w) 2.5)
According to the dynamic equilibrium of an infinitesimal element, we have the dynamic
equilibrium equation
L'e +b = pii + i (2.6)
where p is the mass density and p is the damping factor. L" is the transpose of a linear

differential operator that is defined to satisfy matrix manipulation as
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Equations (2.3) and (2.4) are called the strain-displacement relationships and can be

written as

e=Lu. (2.8)

The stress-strain relationships can be written in matrix form as

6 =D¢ 2.9)

where D is called the elasticity matrix and can be drawn from the theory of elasticity. For

an isotropic material,

(1 -v -v 0 0 0 ]
-v | -v 0 0 0
D"=l -v -v 1 0 0 0
E]0 0 0 2(+v) 0 0 (2.10)
0 0 0 0 2(1+v) 0
(0 0 0 0 0 2(1+v) ]

where E is Young's modulus,v is Poisson’s ratio and the superscript “~1” means the

inverse of a matrix. For an orthotropic material,

[ VE, -v /E, -v,/E. 0 0 0

-vo/E, VE, ~-v,/E. 0 0 0

p | ValE v /E, VE. 0 0 0
0 0 0 UG, 0 0 @.11)

0 0 0 0 UG, 0

0 0 0 0 0 1G




where E; and E| are the Young’s modulus in the x- and y-directions, respectively. Gy, G-
and G are the shear modulus in the xy-, yz- and zx-planes, respectively. v, vy, V),

V., Vi and v, are the Poisson’s ratios and satis
e

wo_ _ 3 _V}: -
= P ETE (2.12)

On a part of the boundary exist surface loads, denoted T\, T, and T-, which are the forces
per unit area in x-, y- and z-directions. The part of the boundary is called force boundary,
denoted as S,, and the surface loads can be written in vector as

T={Tx’T}"Tz}T’ (213)

The boundary that has known displacements @ is called the displacement boundary,
denoted as S,,. Thus, the boundary conditions are expressed by

T=ne (onS,) , u=@ (onS,) 2.14)
where n is an operator consisted of the directional cosines of the outer normal of the force

boundary, n,, n, and n,, and is defined as

n. 0.0 n 0 n
n=0n 0 n n 0 2.15)
0 0 n, 0 n n

2.2.2 Structural Dynamic Equilibrium Equations
In FEM, a structure such as the middle ear system is first discretized as an n-degree
of freedom finite elements system. Every element can be regarded as a continuum as

shown in Figure 2.1 (a). The nodal displacement vector of any element is represented by

d=d,d,d,\" (2.16)

ned

19



where ne is the number of degrees of freedom of the element. Assume displacement

shape functions, N(x,y,z), that relate generic displacements to nodal displacements as

follows:
u=N(x,y,2)d*. 2.17)
The discussion on displacement shape functions can be found in related references 4% &

Babuska 19911 Substituting Eq.(2.17) into Eq.(2.8), it follows that
€ =Lu=LN(x,y,2)d° =Bd* (2.18)
where
B =LN(x,y,2). 2.19)
Substituting Eq.(2.18) into Eq.(2.9) gives
6 =De=DBd" (2.20)
Assuming a small virtual displacement vector 8d° and using Eq.(2.17) and (2.18), it
follows that
ou=Nod*, Je=Bod". 2.21)
Thus, the virtual strain energy oU, in an element can be written as

oU, = [de0dQ2. (222)

And the total virtual work of the body forces, boundary surface forces, inertial forces and

damping forces for an element, oW, , is
o (e T s Tnge s T iy saT e 2.23
oW, = jgu bdQ + Lq'u TdS Lcm pidQ jnou dQ. (2.23)
Applying the virtual work principle, 60U, =W, , to an element gives

[9sTadQ = [su"bd2 + jgnTTds- L ou’ piidQ - [ ou padQ2. (2.24)



This equation is the Galerkin integral form of the dynamic equilibrium equation
Eq.(2.6) and the force boundary condition Eq.(2.14). Substituting Eqs.(2.17), (2.20), and
(2.21) into Eq.(2.24) and canceling od*" from both sides of the equation, we have

( jﬂ pNTNdQ)d® +( jQuNTNdQ)d" +( IQBTDBdQ)d" = I{l;JdeQ+ [yTTds. (2.25)

Thus,
Med® +Cd° +Kd° =F° (2.26)
where

¢ _ T ¢ _ T e _ fRT 227
M —LpN NdQ, C -L,uN NdQ, K _jg DB4Q 2.27)

are the mass, damping and stiffness matrices of the element, respectively. While

F* = [N"bdV + [N"TdS (2.28)
0 s,

is the element nodal load vector. The element nodal displacement vector d° can be
expressed using the system nodal displacement vector X(t) by a transformation matrix G°

as follows:
d° =G*X(1). (2.29)
Substituting Eq.(2.29) into Eq.(2.26), premultiplying matrix G" and summing them for

all elements, we have

Z(GeTMch)x(’) + Z(GeTCeGe)x(‘) + zGcTKeGex(l) = zGeTFu (230)

where

M=YG MG, C=YGCG*, K=Y G KG* .31)

are called the mass, damping and stiffness matrices of the system, respectively. While
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F()=Y GF*

(2.32)

is called the external load vector of the system. Thus the system dynamic equilibrium

equation becomes

MX(r)+CX(t)+ KX(r)=F()

where
m, m;, m, ST Cin

M = m, 'f’zz my, C= €y ‘:zz Cay K
mnl '"n1 mnn cnl cnl cnn

X() = {x, (1), x, (1), o3, (O

F()={F,() F, @) F,0f

In

n

nn

(2.33)

(2.34)

where n represents the total number of degrees of freedom. M, C and K are symmetrical

matrices. The displacement vector, X(t), contains terms that include translations in x-. y-,

and z-directions, and rotations in 6,-, 8y-, and 0,-directions. The external load vector,

F(t), contains terms that include forces in x-, y-, and z-directions and moments in 0,-. 6,-,

and 0,-directions. When the displacement boundary conditions are applied, Eq.(2.33) is

reduced by eliminating the constrained displacements and corresponding rows and

columns in M, C and K. For convenience, the reduced degrees of freedom is still donated

by n and the reduced system dynamic equilibrium equation is still expressed as

Egs.(2.33)~(2.36). Right now, M, C and K are symmetric positive definite matrices.
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2.3 Solution Of Structural Dynamic Response

When the dynamic equilibrium equation of the middle ear system is obtained using
the basic principles of finite element method, we can solve the system for the structural
response. In this section, the modal superposition method is described to solve the
displacement response of the system to harmonic loads. The natural frequencies and
natural modes are first calculated through the undamped free vibration analysis of the
system. Then the displacement response is expressed as the linear combination of the
natural modes of the system. The dynamic equilibrium equation is decoupled using
Rayleigh damping assumption and the orthogonal properties of natural modes, and then

solved numerically.

2.3.1 Undamped Free Vibration
The undamped free vibration is represented by Eq.(2.33) without damping (C = 0)
and external load (F = 0). The result is a matrix equation of motion
MX()+KX()=0. 237

Assume the solution of Eq.(2.37) as

x| (&) 15(:)
X(n= xzz(l) = azz(t) coswt + bzf’) sinot = Acoswt + Bsinot . (2.38)
x, () (@, b, (1)

Substituting Eq.(2.38) into Eq.(2.37) and collecting terms gives
[-Mo? +K]A cosot + [-Mo® + K]Bsinot = 0. (2.39)

Since sinmt and cosmt cannot be zero at the same time, therefore



[-Mo® +K]A =0, [-Mo’+K]B=0. (2.40)

The non-trivial solution of Eq.(2.40) can be obtained by setting the determinant of the
matrix [-Mo® +K] to zero, i.e.,

Mo’ +K|=0. (241)

Equation (2.41) is an n"-order polynomial, and therefore there are n unknown . Since

both M and K are symmetric positive definite matrices, there will always be n real

. 2 . .
solutions of ", denoted as ©;,®;3,--,w}, which satisfy

19
[N

<...<& mz (2.42)

n’

0; <0
The smallest value of w; (i.e., @) is referred to as the fundamental natural frequency of

vibration, the second smallest value of o; (i.e., ®;) is called the second natural frequency
of vibration, and so forth. The quantity of @ is called the i™ eigenvalue of the system.
Each natural frequency of the system has a corresponding eigenvector, denoted as @, .
And o;and @, are related by the equation

[-Mo? +K]p, =0. (2.43)
The eigenvectors are called natural modes of the system, which take the form

?. ={(pln(p2n”'y(P,,, }T- (244)

The n solutions of @ previously computed show that the response of the structure can be

represented as the combinations of » natural modes. Therefore,
X = Z[X, coso,t+ B sinm,t]. (2.45)
1=l

When Eq.(2.45) is substituted into Eq.(2.37), it follows that
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Z'[-Ma),2 +K][A, coso,t +B,sinw,t]=0. (2.46)

Therefore, to obtain a nontrivial solution, it must follow that
[-Mo? +K]A, =0, [-Mo? +K]B, =0. 2.47)

Comparing Eq.(2.43) with Eq.(2.47) gives

K: = al@l ’ ﬁl = bl¢l . (2'48)
It follows from Eq.(2.45) that
X(n= Zcp,[a, cosw,t+b sinwt]= Zcp,q, t) (2.49)
1=l 1=l
where
q,(t)=a,cosmt+bsinot. (2.50)

This is the solution of the undamped free vibration. The values of @, and b, can be

determined based on the given initial conditions.

2.3.2 Orthogonality Of Natural Modes
Since the orthogonal properties of natural modes are the prerequisite for decoupling

the dynamic equilibrium equations, we discuss them in detail in this section. Natural
frequencies of vibration, ®;,®3,+-,®’, and the natural modes, @,,9,,--,@, . satisfy the

eigenvalue equation. The norm (or length) of any natural mode is defined as

9.] = y(©.)* +(©,)* +--+(®,)* . 2.51)

Because each natural mode has an arbitrary scaling factor, they can always be normalized

with the norm equal to 1. This type of normalization of natural modes is called norm
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normalization. Denoting the normalized natural modes as @,,9,,"-*,9,, it then follows

that

T
,5‘:{2“_,&,...,&_} ={6,,6,,..9,,} . (2.52)
ol led" led

The advantage of the norm normalized natural modes is that the sizes of the elements in

the natural modes do not become large and thus do not result in numerical ill-
conditioning when used in other matrix equations. If Eq.(2.43) is divided by the norm of

the natural mode @, , then it follows that

1 [-Mo? +K]e, =[-Mo’ +K]§, =0.

o]

Consider the natural frequencies of vibration, ®, and ©,, and their corresponding

(2.53)

natural modes, @, and @, . Equation (2.53) can be written for each natural frequency, and
it follows that
[-Mo; +K]9, =0 (2.54a)
[-Mo} +K]p, =0. (2.54b)
Premultiplying Eq.(2.54a) by @, , Eq.(2.54b) by §; gives
$7[-Mo] +K, =0 (2.552)
$T[-Mo® +KIp, =0. (2.55b)
Since both M and K are symmetrical matrices, it follows that
&, Mo, =9,;M9,, 9;Ko, =9/K9,. (2.56)
Substracting Eq.(2.55b) from Eq.(2.55a) and using the property of the mass matrix M and

stiffness matrix K in Eq.(2.56), it follows that
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M9, (0] -0})=0. (.57
For any o, # @, it follows that @M@, =0. This is known as the orthogonal property

of two natural modes with respect to the mass matrix M. A similar orthogonal property of

two natural modes with respect to the stiffness matrix K can also be derived from

Eq.(2.55). It states that §'K¢, =0 for any ®, #©,. In summary, the orthogonal

property for the system mass and stiffness matrices states that

cTern et |k i=
¢IK¢,=¢TK¢,={' Y (2.58)
0 i=].

m, Q=

ATMA =A‘]‘MA =
?,Mo, =@, M9, 0 i%j,

Define the modal matrix of norm normalized natural modes to be

(bll (blz “bln
b=(p.6,9,0= 7 P2 O (2.59)

t‘bnl (pnl (bnn

and it follows that

m 0 0 k, 0
medmb=| ) ™ V| k-dké=|" R - O e
0 0 - i, 0 0 - &,

Note that these relationships exist for any normalization of the natural modes although

the orthogonal relationships were derived using the norm normalized natural modes.



2.3.3 Damped Response
Having the discussions in Sections 2.3.1 and 2.3.2, we can solve the middle ear
system for the structural response. Using the modal superposition method, the structural

response is expressed as a linear combination of its natural modes
X()=9,9,()+9,9,) ++9,q,(1) = ‘i’Q(l) (2.61)

where ¢q,(t),q,(1),---,q,(¢) are called the generalized coordinates and

Q) ={g, (0.4, .0, (262)
is called the generalized coordinate vector. For a large system, it may not be feasible to
calculate all the natural frequencies and natural modes. Consider the first &k natural

frequencies and natural modes, where & < n, then Eq.(2.61) becomes

X(1) = 9,4,(0) + 9,9, ++- + ., () = DQ(1) (2.63)
where
P B By 9,
PRSI R T LB RN A I L (2.64)
P 0 o Py 2, (1)

Note that @ isa nx k matrix that is not a square matrix. Substituting Eq.(2.63) into the

dynamic equilibrium equation, Eq.(2.33), it follows that
MOQ(r)+ CDQ(r)+ KDQ(r) = F(). (2.65)
Premultiplying Eq.(2.65) by ® gives
®"MOQ( )+ D'CHQ(r)+ D' KDQ(r) = DF(r). (2.66)
Using Rayleigh proportional damping, the damping matrix C is a linear combination of

the mass and the stiffness matrices:



C=ueM+BK.

(2.67)

where « and B are the damping parameters and their units are s (second™) and

s (second), respectively. Because the natural modes are orthogonal to the mass and

stiffness matrices, the modes will be orthogonal to the damping matrix. Therefore. it

follows that
@ [m m, - m, | (i, 0 - 0
. ~ et im, m, . om . . . 0 m, .
®'MP = q’:‘ g - [6,.0:..0,]= =M (2.68a)
6]{ mnl mn’ mnn 4 L 0 0 ';lk
@ [k Ky o li /;l 0 0
N A AI I(, k*n . k» a A N A, .
FeNro L LIS [y i) = 0 k= 0N g (268b)
(i’: knl an knn- _0 0 vt kAk
®'Cd = d'(aM +PK)D = ad'M®D + O KD
ah, +Bk, 0 - 0 & 0 - 0
S0 el o 0 106G 0 e 68
0 0 - am +Pk | [0 O - ¢
Substituting Eq.(2.68) into Eq.(2.66) gives
M)+ CO)+ RQ() = DTF(). (2.69)

Equation (2.69) represents k uncoupled equations, each of which takes the form

g, (t)+¢,4,()+k,q,(6)=6]F()

or alternatively

§,(1)+26,0,4,(0)+ 0}q,() = 9] F(t)/ ,
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(2.70)

(2.71)



where o, is the " natural frequency and , is called i modal damping. They are defined

as

(3

o=k /m, 2o =¢/m 2.12)
When the external load vector F(l) in Eqs.(2.33) and (2.71) is sinusoidal loads with
frequency p as
F(t)=F,sinpt, (2.73)
the oscillating motion forced by this type of loads is called harmonic response or
frequency response. The i™ uncoupled dynamic equilibrium equation becomes
G.(1)+20,0,4,(c)+ 0lq,(t)= £, sin pt/ m, 2.74)
where
fo, =¢TF0 2.75)
The particular solution (steady response) takes the form
q,(t)= 4, cos pt + 4, sin pt (2.76)
Substituting Eq.(2.76) into Eq.(2.74) gives

- p*(A, cos pt + 4, sin pt) + 2{,®, p(~ 4, sin pt + A, cos pt)
+ 0’ (4, cos pt + A, sin pt) = f;, sin pt/ m, 2.77)

Collecting the cosine terms into one equation and the sine terms into another equation

gives the two simultaneous equations for 4; and 4. These equations are
-p’4 +25,0,p4, +0} 4, =0 (2.78a)
-p 4, -0, pA +0’A, = f, Im,. (2.78b)
Let r = p/o,, which is the ratio of the forcing frequency to the i natural frequency of

the system. Solving Eq.(2.78) gives



- _2
4, = "&( 2 -ZC,", z]’ 4, = '40"'[ 112 - 2]‘ 2.79)
k A\ QA=-r2) +8r) k, \(-r") +(2C,r)
It follows from Eq.(2.76) that

ok
(1-r3) +(2,r)

q,()= (— 20,r,cospt +(1 -r,2 )sin pr). (2.80)

Substituting Eq.(2.80) into Eq.(2.63) gives

X(r)=2k:<i>,q,(t) = i f" L -(= 20,7, cos pr + (1= £7)sin pr)9, (2.81)
1=l o (1=r") +(Q2C,r)

This solution is the displacement response of the system to harmonic exciting loads.
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2.4 Damping Parameters

Damping is an important dynamic characteristic of structures. It is also an important
parameter for biological systems. However, the damping effect is hard to determine
because the damping factor p of a material is hard to evaluate. In engineering, the
damping effect of a material is considered by assuming certain damping parameters such

as Rayleigh damping parameters, o and B. These parameters are converted to the modal

damping (. that appears in Eq.(2.81). When Rayleigh damping is used, the values of a

and P can be determined by assuming first two modal dampings. Then the modal

damping ¢; for i™ modes can be obtained by the following equation

_a+po; (2.82)

g 20,
Although the Rayleigh damping parameters were assumed for the whole system in
the above discussion, they also can be assumed for any subsystem to deal with different
materials used in the system. Of course, the damping factor u can be directly used for the

mass-spring-damper system. Some commercial finite element analysis codes such as

ANSYS employ the similar damping expressions.



2.5 Element Types Employed In The Research
To build the finite element model of human middle ear, four types of elements were

employed. The section provides the descriptions of ANSYS element types used in the

finite element model.

2.5.1 COMBINI14 Spring-Damper Element

COMBINI14, as illustrated in Figure 2.2, is the spring-damper element that has
longitudinal displacement in one, two or three dimensions. The element is a uniaxial
tension-compression element with two nodes / and J, each having up to three degrees of
freedom: translations in the nodal x-, y-, z-directions. No bending or torsion load are
considered. It is massless. In Figure 2.2, k and p are the spring constant and the damping

coefficient of the damper, respectively. F, d; and d; are the axial force and displacement

at points / and J, and have a relation of F =—kld, —djl—pld, —dJ’. COMBIN14 was

employed to model the stapedius annular ligament and the cochlear impedance.

Figure 2.2 COMBIN 14 spring-damper
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2.5.2 SHELL41 Membrane Shell Element

SHELL41, illustrated in Figure 2.3, has membrane (in-plane) stiffness but no
bending (out-of-plane) stiffness. Only normal loads are permitted. The element is defined
by four nodes, /, J, K and L, each having three degrees of freedom: translations in the
nodal x-, y-, z-directions. The element can be the quadrilateral element or triangular
element. The circled numbers in Figure 2.3 represent the surface identification. SHELL41

was employed to model the eardrum, which will be presented in Chapter 3.

KL

(Triangular Option)

Y Note - x and y &e inthe plane of the elemens.
x is along side [-J if THETA=0.

Figure 2.3 SHELL41 membrane shell

2.5.3 SOLID4S 3D Structural Solid Element
SOLID45, illustrated in Figure 2.4, is used for the three dimensional modeling of
solid structures. The element is defined by eight nodes, /. J, K, L, M, N, O and P, each

having three degrees of freedom: translations in the nodal x-, y-, z-directions. The
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element can be the hexahedral (brick element), pentahedral (prism element) or
tetrahedral. The circled numbers in Figure 2.4 are the surface identification numbers. The

element type was employed to model the ossicles, ligaments and muscles.

[+3 4

[ RL

J
Pentahedral Element

M,N, 0P
[
KL

J
Tewrahedral Elemert

Elsmere Coardinate System

N

v Surface coordinae system

Figure 2.4 SOLID45 3D structural solid

2.5.4 SHELLG63 Elastic Shell Element

SHELLG63, illustrated in Figure 2.5, has both bending and membrane capabilities.
Both in-plane and normal loads are permitted. The element is defined by four nodes, /, J,
K and L, each having six degrees of freedom: translations in the nodal x-, y-, z-directions
and rotations about the nodal x-, y-, z-axes. The element can be the quadrilateral element
or triangular element. The circled numbers in Figure 2.5 represent the surface

identification. The element was employed to model the eardrum, which will be discussed

in chapter 5.
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Element Coordinate System ®
(x and ¥ are 1 the plane of the element ) 133

[

Figure 2.5 SHELLG63 elastic shell
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CHAPTER THREE

PRELIMINARY STUDY OF HUMAN MIDDLE EAR

MECHANICS

Before developing the computer integrated modeling and simulating method, a
simple FE model was created to provide a quick look of the behaviors of the middle ear.
In addition, the simple model provides the FE modeling experience for creating the next
more accurate model by using serial histological sections of a human temporal bone. This
simple model provides:

(1) Preliminary understanding on the anatomy and functions of human middle ear;

(2) Valuable FE modeling experiences that can be used to build a more accurate FE
model;

(3) Thorough investigation about the physiological ranges of mechanical properties of
the human middle ear;

(4) Initial observations about the effects of the physical parameters and boundary

conditions on middle ear mechanics.

3.1 Structures And Functions Of Human Ear

A human ear is divided into three sections: the outer ear, the middle ear and the inner

ear, as shown in Figure 3.1.
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The outer ear consists of the external pinna (auricle) and auditory meatus (ear canal),
which is terminated by the tympanic membrane (eardrum). The pinna helps to collect
sound and determine the direction of sound sources of high frequency. The ear canal acts

as a pipe resonator that boosts hearing sensitivity in the range of 2,000 to 5,000 Hz.

semicircular canals
oval window

Outer Ear ' Middle Ear ' Inner Ear

Figure 3.1 A schematic diagram of human ear

The middle ear lies in a cavity of complex form in the outer, mastoid portion of the
temporal bone. The cavity is filled with air and connects the middle ear to the pharynx
through the Eustachian tube to provide a means of pressure equalization. The middle ear
begins with the eardrum, to which are attached three small bones (ossicles). The eardrum,
which is a fiber composite with a cross section consisting of several layers and regions, is
kept taut by the tensor tympani muscle. The eardrum ultrastructure study shows the
regularity of the radial and circumferential fibers appearing in the pars tensa ™ 1% & 1970

Shimada & Lim 19711 These two sets of fibers represent a majority of the stiff fibers appearing

38



in the eardrum. The main portion of the eardrum (pars tensa) is firmly held in a groove in
a bony ring formed by the walls of the ear canal, except in a triangular region (pars
flaccida) at the upper border (notch of Rivinus) where this ring is incomplete and the
connection is lax. The eardrum changes the pressure variations of incoming sound waves
into mechanical vibrations to be transmitted via two distinct mechanisms: “ossicular
coupling” and “acoustic coupling”” [Peake et al 1992: Merchant exal. 1997 & 1998)

The first ossicle, the malleus, is attached to the eardrum along a radius running from
the notch of Rivinus to the center of the eardrum (umbo) by the handle (manubrium) of
the malleus. The second ossicle, the incus, extends from the malleus to the third ossicle,
the stapes. The stapes has its footplate held firmly in the oval window by the stapedius
annular ligament. The three ossicles are joined by means of articulations and suspended
in the middle ear cavity by ligaments, muscles and attachment. They are the tensor
tympani muscle, the posterior stapedial muscle, the superior, anterior and lateral
ligaments of the malleus, the posterior ligament of the incus, and the malleus attachment
on the eardrum, as shown in Figure 3.2.

The ossicles play a very important role in the hearing process. They act together as a
mechanical transformer to fulfill the “ossicular coupling” of sound transmission from the
eardrum to the cochlea. Another function of the ossicles is to protect the inner ear from
very loud noise and sudden pressure change. Loud sound triggers two sets of muscles:
tensor tympani muscle tightens the eardrum and posterior stapedial muscle pulls the
stapes footplate away from the oval window of the inner ear.

The inner ear contains the semicircular canals, the vestibule and the cochlea. Only
the cochlea is concerned with hearing. The other parts are the body’s horizontal-vertical

detectors necessary for balance. The cochlea is filled with liquid (cochlear fluid) and
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Figure 3.2 The anatomy of human middle ear




Oval window Auditory nerve  Reissner's membrane

Organ of corti

Round window

Cochlear duct Basilar membrane

Figure 3.3 Schematic diagram of cochlea

surrounded by rigid bony walls. Its cross-section shows three distinct chambers that run
the entire length: the scala vestibuli, the scala tympani and the cochlear duct, as shown in
Figure 3.3. Resting on the basilar membrane is the delicate and complex organ of corti
that contains several rows of tiny hair cells to which are attached nerve fibers. When the
stapes footplate vibrates against the oval window, hydraulic pressure waves are
transmitted rapidly down the scala vestibuli, inducing ripples in basilar membrane. When
the basilar membrane vibrates, the hairs of the hair cells are bent, thus generating nerve
impulse to the brain. The impulse rate on the auditory nerve depends on both the intensity

and fre quency of the sound [Rossing 1990; Wever & Lawrence 1954; Anson & Donaldson 1981]
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3.2 Sound Pressure Level (SPL)

In Section 3.1, we discussed the anatomy and functions of human ear. In the process
of hearing, our ears respond to the sound pressure stimuli of sound waves. In a sound
wave, there are extremely small periodic variations in atmospheric pressure to which our
ears respond in rather complex manner. The minimum pressure fluctuation to which the
ear can respond is less than one billionth of the atmospheric pressure at sea level. This
threshold of audibility, which varies from person to person, corresponds to a sound
pressure amplitude of about 2x10~° N/m’ at a frequency of 1,000 Hz. The threshold of
pain corresponds to pressure amplitude approximately one million times greater, but still
less than one thousandth of atmospheric pressure. Because of the wide range of pressure
stimuli (p), it is convenient to measure sound pressures on a logarithmic scale, called the
decibel (dB) scale. Although a decibel scale is actually a means for comparing two

sounds, we can define scale of sound level by comparing sounds to a reference sound

with standard reference sound pressure p, =2x10~° N/m*. The Sound Pressure Level

(SPL), denoted by L, , is defined as

3.1
L, =20log (aBsPL) . G-l
Do
Thus the conversion formula from SPL to pressure is
L L (3.2)

p=p,10%° =2x10°x10®  (N/m?) .
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3.3 A Simple Human Middle Ear FE Model

The construction of the middle ear geometry is the first step to build a three-
dimensional finite element model. HyperMesh [ Comins 1 3 commercial FEA pre- and
post-processing software, was employed to build the simple model. The model consisted
of the eardrum, the ossicular chain, and associated ligaments and muscles. The basic
geometric data of the middle ear components and the original authors are listed in Table
3.1. However, most of the data came from Wever & Lawrence’s book [Wever & Lavrence 1953]
The key dimensions and characteristics of the entire middle ear system are shown in

Figure 3.4 that was drawn by Gan “ "l based on Wever e al.’s desciptions (V<" &

Lawrence 1954; Kirikae 1960; Awengen ef al. 1996; Gulick et al. 1989; Anson & Donaldson 1981]

Table 3.1 Basic anatomic data for human middle ear

{Published Data [Sources
Diameter along manubrium 8.0~10.0 mm Gray 1918 *
Diameter perpendcular to manubrium 7.5~9.0 mm Helmhoitz 1863 *
1.54 mm ‘Wada et a/. 1992
2.00mm Siebenmann 1897 *
55.8~85.0 mm* Wever & Lawrence 1954, Keith 1918°
von Békésy 1941 *
Thickness 0.1 mm Heimhoitz 1863 *
0.04~0.075 mm Kirikae 1960
0.132 mm Wada et al. 1992
MALLEUS
Length from end of manubrium 5.8 mm Stuhiman 1937 *
to end of lateral process
Total Length [7.6~9.1 mm Bast & Anson 1949 *
Weight 23~27 mg Stuhiman 1937 *, Wever & Lawrence 1954
INCUS
Length along long process 7.0mm Stuhiman 1937 *
Length along short process 5.0 mm Stuhiman 1937 *
eight 25~32 mg Stuhiman 1937 *, Wever & Lawrence 1954
STAPES
Height 2.5~4.0 mm Stuhiman 1937 *, Wever & Lawrence 1954
Length of footplate 2.64~3.36 mm Wever & Lawrence 1954

2.5mm Our Measurement
Width of footplate 0.7~1.66 mm Helmholtz 1863 *, Wever & Lawrence 1954
eight 2.05~4.35 Wever & Lawrence 1954

* The work was done by the listed authors but the data came from Wever & Lawrence’s book [Wever & Lawrence 19541
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Figure 3.4 Schematic drawing of human middie ear




Eardrum

The eardrum was modeled as an unsymmetrical spatial elliptic conic shell. The
geometry was obtained by trimming an elliptic conic surface with a long bottom radius of
5.659 mm, a short bottom radius of 4.523 mm and a height of 2.0 mm using an elliptic
cylindrical surface with a long bottom radius of 4.6 mm and a short bottom radius of
4.342 mm. Then the trimmed surface was meshed with 127 triangular and quadrilateral

membrane elements with a uniform thickness of 0.132 mm, as shown in Figure 3.5(a).

(a) Eardrum (b) Malleus

d ,'

-

£

X

(c) Incus (d) Stapes

Figure 3.5 Geometric characteristics of the simpie model
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Ossicles

The characteristic points, lines and surfaces were first created based on the key
dimensions of the ossicles listed in Table 3.1 and the relative position of the ossicular
chain in space shown in Figure 3.4. Then the FE model was built by directly creating
solid elements using these characteristic points, lines and surfaces. The whole ossicular
chain consisted of 181 8-node-hexahedral, 6-node-pentahedral, and 4-node-tetrahedral
solid elements, as shown in Figure 3.5 (b, c, d).

The dimensions of eardrum, malleus, incus and stapes were defined in four local
reference frames. Then each of these component FE models was transformed into the
global coordinate system by transforming the corresponding reference frame to global

coordinate frame.

Ligaments and Muscles

There are four ligaments and two muscles included in the model, following the
drawing shown in Figure 3.4. They are the superior mallear ligament (C1), the lateral
mallear ligament (C2), the anterior mallear ligament (C4), the posterior incudal ligament
(C3), the posterior stapedial muscle (CS5) and the tensor tympani muscle (C7). Each
ligament or muscle was modeled as a set of linear springs (COMBIN14 elements) along

three orthogonal directions.

Middle Ear FE Model
The middle ear FE model was created by assembling these individual components in
global coordinate frame and applying the boundary conditions and loads. The eardrum

and the malleus were coupled along the manubrium by coupling their corresponding
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nodes. The malleus, incus and stapes are connected at incudomalleolar joint and
incudostapedial joint by coupling their corresponding nodes respectively. Each ligament
or muscle was attached to the appropriate position of the ossicles at one end and fixed at
another end. The tympanic ring was modeled as a set of linear springs (COMBIN14
elements) along three orthogonal directions to simulate the elastic boundary of the
eardrum. The impedance of the cochlear fluid (C6) was simplified as three linear springs
with dashpots (COMBIN14 elements). Consequently, the ossicles were held on the
eardrum by the malleus, and in the oval window by the stapes footplate with resistance
provided by a set of linear springs with dashpots. The ossicles were also supported by six
sets of linear springs. The eardrum was supported by a set of linear springs. The simple

middle ear FE model is shown in Figure 3.6.
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Isometric View

Figure 3.6 A simple finite element model of human right middle ear
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3.4 A Review On Mechanical Properties Of The Middle Ear

It is very difficult to determine the mechanical properties of biological materials
because either they cannot be isolated for testing or the size of the available specimens is
too small to conduct meaningful measurement. Furthermore, it is difficult to keep these
specimens in the normal living conditions for measurements " '*¢l Consequently,
there are not many experimental data published for mechanical properties of the middle
ear. A thorough literature survey was conducted for available mechanical property data of
the middle ear. Results of the survey are listed in Table 3.2 and 3.3. Note that the data
listed in these tables came partly from experimental measurements, but mostly from
estimates. Almost all of the ligament and muscle properties came from estimations.
Although the damping coefficients of the middle ear were reported in some papers, big
differences existed among the data from different sources. The exception is the damping
coefficient of the cochlear fluid, which is 0.620 N-s/m Wadaeral- 1961 634 N.g/pm (Kotke etal.
19961 10,717 N-s/m [Fems et al 2000} 44 0,737 N-g/m [Prendereast er al 19991 gowever. it was at
specific frequencies that these values were obtained. Therefore, they cannot be used as a
standard to select the damping coefficient of the cochlear fluid. This will be discussed in
Chapter 5.

For this simple model, the mechanical properties of the middle ear components
were assumed homogeneous and isotropic, and were selected based on those listed in
Table 3.2. The densities of malleus, incus and stapes were determined by dividing their
corresponding weights obtained from Table 3.2 by their respective volumes obtained
from the FE model. It is because the coarse geometry of the FE model caused overlarge
volumes of the ossicles so that we had to use the calculated densities to match the weights

of the three ossicles. The mechanical properties used for the main components of the
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Table 3.2 Published mechanical properties of middle ear components

EARDRUM Published Data Sources
Density (kg/m”) 1.0x10’ Funnell ot a/. 1983, 1987, 1992
1.2x10° Williams et al. 1990
Wada et al. 1990, 1992, Beer et al. 1996
Ferris et al. 2000,
Young's Modulus (N/m*)
isotropic|2.0x10 von Békésy 1949, 1960
Funnell et a/. 1978, 1983, 1987, 1992, 1996
2.0<107 (pars tensa), 1.0x10” (pars flaccida) | Ladak et al. 1996
3.2x10’ Wada et al. 1992
3.3x107 (pars tensa), 1.1x107 (pars flaccida) | Wada et al. 1990, 1996
4.0x10’ Kirikae 1960
1.0x10’~ 2.0x10° Williams et al. 1990
Anisotropic]4.0x10%~ 4.0x107 (circumferential, pars tensa) | Prendergast, Ferris et al. 1999
Ferris, Prendergas et al. 2000
2.0x10"~ 4.0x10’ (radial, pars tensa) Prendergast, Ferris et al. 1999
Ferris, Prendergas et al. 2000
1.0x10’(pars flaccida) Prendergast, Ferris et al. 1999
Ferris, Prendergas et al. 2000
2.0x10 (circumferential), 3.2x10’ (radial) Beer ot al. 199
MALLEUS
Density (kg/m”) 2.55x10° (for head) Kirikae et al. 1960, Wada et al. 1992
4.53x10 (for neck)
3.70x10° (for handle)
2.30x10° Williams et al. 1990
I‘Weigm (mg) 23~27 Stuhiman 1937 . Wever ot al. 1954
Young’s Modulus (N'm?)  [1.00x10" Funnell et a/. 1978, Williams et a/. 1980
1.20x10" Wada et al. 1996
1.41x10" Kirikae et al. 1960, Herrmann et al. 1972
Koike 1996, Wada et al. 1992, 1996
1.483x10" Speirs et al. 1999
2.00x10" Prendergast et al. 1999
Funnell et al. 1992, 1996
INCUS
Density (kg/m’) 2.36x10° (for body) Kirikae et a/. 1960, Wada et al. 1992
2.26x10° (for short process)
5.08x10° (for long process)
2.30x10° Williams et a/. 1990
[Weight (mg) 25~32 Stuhiman 1937 , Wever ef al. 1954
Young's Modulus (N/m%)  {1.00x10° Funnell et al, 1978, Wiliams et al. 1990
1.20x10" Wada et al. 1996
1.41x10" Kirikae et a/. 1960, Herrmann et al. 1972
Koike 1996, Wada et al. 1992, 1996
Speirs et al. 1999
2.00x10" Prendergast et al. 1999
Funnell et al. 1992, 1996
STAPES
Iﬁensitv (kg/m’) 2.20-10° Kirkae 1960
2.30x10° Williams et al. 1990
'eight (m 2.05~4.35 Wever et al. 1954
Young' Modulus (N/m?) 1.00<10" Funnell et al. 1978, Williams et a/. 1980
1.20x10" Wada et al. 1996
1.41x10"° Kirikae et al. 1960, Herrmann et al. 1972
Koike 1996, Wada et al. 1992, 1996
Prendergast et al. 1999
2.00x10'° Funnell et ai. 1992, 1996
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Table 3.3 Published mechanical properties of ligaments, muscles,
joints and cochlear fluid stiffness

Ligaments/ Muscles Young's Modulus or Spring Constant
Boundary Conditions _ Published data | Source
Superior mallear ligament (C1) 4.9x10° N/m* Beer of al. 1996
| Lateral mallear ligament (C2) 6.7x10° N/m* Beeretal 1996 _
Posterior incudal ligament (C3) 6.5x10° N/m* Wada et al. 1996, Prendergast 1999, Ferris et al. 2000
Anterior mallear ligament (C4) 5.2x10° Nm* Beer ot al. 1936
2.1x10° N'm? Wada et al. 1996, Prendergast 1999, Ferris et al. 2000
Posterior stapedial muscie (C5) 7.4x10° Nim* Beer of al. 1996
5.2x10° N'm? Wada et al. 1996, Prendergast 1999, Ferris et a/. 2000
Cochlear fluid (C6) 440 N/m (for cat) Ladak et al. 1996
510 N/m (for cat) Funnell et al. 1978
- e — ON/m Wada et al. 1996
Tensor Tympani tendon (C7) 1.4x10° N/m* Beer of al. 1996
2.6x10° N'm? Wada et al. 1996, Prendergast 1999
Incudomalleolar joint
Incudostapedial joint 6.0x10° Nim* Wada et al. 1996, Erendergast 1999, Ferris ef al. 2000
Stapedial annular ligament 6.5x10° N/m* Wada 6t al. 1996, Prendergast 1999, Ferris et al. 2000
1.0x10* N'm? Lynch et al. 1982

simple model are listed in Table 3.4. As shown in Table 3.4, the densities are much less
than the published data in Table 3.2.

Because the ligaments and muscles were modeled as a set of linear springs along the
three directions of the global coordinate system, it was inconvenient to adopt the stiffness
data for the ligaments and muscles based on Table 3.3. In addition, there lack reliable
published damping data. Thus the initial FE model was created without ligaments,
muscles and damping. In this initial model, the stiffness of cochlear impedance was set to
440 N/m based on Ladak ef al. estimation 123 ¢/ o 1% 354 the spring constants of the
eardrum supports were set to 10° N/m to simulate the fixed constrains. The adjustment of
the initial FE mode focused on the adjustments of the stiffness of ligaments and muscles
and the damping parameters of the system.

Table 3.4 Mechanical properties of the middle ear components
employed for the simple FE model

Properties Eardrum Malleus Incus Stapes
Density: p (kg/m") 1.2x10° 0.85x10° 1.35x10° 1.56x10°
Young's modulus: E (N/m") 3.2x107 1.41x107_ 141007 141x10"
Poisson's ratio: v 0.3 0.3 0.3 03
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3.5 Simple FE Model Calibration

The experimental measurements used for the simple FE model calibration were
conducted by Gan e al. on seventeen normal fresh-frozen, cadaveric temporal bones (age
32 to 96 years, 13 males and 4 females) (9" ¢/ - 2%/ A small reflective tape was placed
on the center of the stapes footplate to serve as a laser-reflective target. When pure tone
narrow band, filtered sound of 90 dB SPL was delivered near the eardrum in the ear
canal, the displacement of the stapes footplate caused by the sound pressure on the
eardrum was measured across the frequency range of 250-8,000 Hz. The measurement
was conducted using a single point laser Doppler interferometer by focusing the helium-
neon laser beam onto the reflective tape on the center of the stapes footplate. The
measured mean peak-to-peak displacement of the stapes footplate on the seventeen
temporal bones was employed to calibrate the FE model. The mean curve was employed
instead of 17 curves so that the average trend of the frequency response curves of the
stapes footplate displacement can be captured easily.

To be consistent with the experimental setup, the simple FE model was applied a
uniform pressure of 90 dB SPL (0.632 N/m’) on the lateral side of the eardrum. The
harmonic analysis was conducted on the FE model across the frequency range of 250-
8,000 Hz. The displacements of the stapes footplate in frequency field were collected and
converted to the peak-to-peak displacement response of the stapes footplate. The
objective of the FE model calibration process is to match the FE model prediction with
the experimental curve obtained by the laser Doppler interferometry (LDI) as close as
possible, by adjusting undetermined model parameters of the simple model. The curve
obtained from the initial model was shown in Figure 3.7 with the LDI curve, the mean of

17 experimental curves.
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Figure 3.7 Stapes footplate displacement frequency response for the initial FE model

During the FE model calibration process, the dimensions and geometric shape of the
model were kept constant. The published mechanical properties were selected for the
main middle ear components. The parameters to be adjusted were mainly limited to the
mechanical properties of ligaments, muscles and eardrum periphery support. In another
word, the FE model calibration process was nothing but finding an optimum combination
for the mechanical properties of ligaments and muscles by means of the cycling
optimization method [ReKs ¢ al 19831 The stiffness of the ligaments or muscles was
alternatively cycled to search for a set of optimum ligament or muscle stiffness values.

Next, we show how to estimate the adjustment ranges for the stiffness of ligaments
and muscles. According to Wever and Lawrence’s work, the length and cross-sectional
area of the tensor tympani muscle are 25 mm and 5.85 mm® respectively, and the length

and cross-sectional area of the posterior stapedial muscle are 6.3 mm and 4.9 mm’
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respectively [Wever and Lawrence 19531 By a5uming a muscle to be a bar (a two-force element),
then we can estimate the longitudinal stiffness of the muscle by the following formula:

_E4 (3.3)

where £ is the longitudinal stiffness; L and A are the length and the cross-sectional area of
the muscle, respectively; and E is the Young’s modulus of the muscle. If the bar is
regarded as a spring, the longitudinal stiffness is its spring constant. In Table 3.3, there
are two values, 1.4x10* N/m” and 2.6x10° N/m?, for the Young’s modulus of the tensor
tympani muscle; and two values, 7.4x10* N/m* and 5.2x10° N/mz, for the Young’s
modulus of the posterior stapedial muscle. Based on the above discussion, we estimated
two spring constant values, 3.3 N/m and 608.4 N/m, for the tensor tympani muscle; and
two spring constant values, 57.6 N/m and 404 N/m, for the posterior stapedial muscle.
Therefore the stiffness adjustment range of the muscles was set to be between 0 and 1000
N/m. Under the assumption that the stiffness difference among ligaments and muscles is
not too large, the stiffness adjustment range of ligaments were also set to 0~1000 N/m.

In the adjustment range, the cycling processes were conducted. The first ligament C1
was added to the initial model. The stapes footplate frequency response curves with the
stiffness values of 0, 100, 200, 300, 400 N/m for ligament C1 were calculated. The curves
of different stiffness values obtained from finite element analysis (FEA) were compared
with the experimental curve, as illustrated in Figure 3.8. In the figure, it is seen clearly
that the stiffness of ligament C1 affects the frequency response curve significantly. From
these curves, the stiffness value that gives the “best” curve oscillating along or closest to
the experimental curve was adopted. In this case, the value of 300 N/m was selected for

ligament C1. Then the second ligament was added with the first ligament kept in the
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Figure 3.8 Select the optimum stiffness value of ligament C1

model. The same procedure was conducted and the “best” stiffness value was obtained
for the second ligament. When the “best” stiffness value for the last ligament or muscle
was adopted, the first cycle ended. The stapes footplate displacement response curve after
completing first cycle is shown in Figure 3.9. The stiffness values are 300, 400, 400, 300,
50, 300 N/m, respectively, for ligaments C1, C2, C3, C4, C5 and C7.

The second cycle started with the set of ligament or muscle stiffness values obtained
from the first cycle. The same procedure was used except keeping all ligaments and
muscles in each step. When the cycling procedure was performed several times and the
frequency response curve obtained from the FEA could not be further improved, the set
of ligament or muscle stiffness values was accepted.

The same method was employed to search for the optimum cochlear fluid impedance

stiffness, the Young’s modulus of the eardrum and the damping coefficients of the
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Figure 3.9 FE stapes footplate displacement response curve after first cycle

model. Figure 3.10 shows the stapes footplate displacement frequency response curve

using the optimum combination of the mechanical properties that is shown in Tables 3.5

and 3.6.

Table 3.5 Mechanical properties of the human middle ear simple FE model

Properties Eardrum Malleus Incus Stapes
Density: o (kg/m") 1.2x10° 0.85x10’ 1.35x10° 1.55x10°
Young's modulus: E (N/m°) 1.6x10" 1.41x10° 1.41x10" 1.41x107
Poisson's ratio: v 0.3 0.3 0.3 0.3
Damping coefficients: B (s) 0.0001 0.0001 0.0001 0.0001

Table 3.6 Boundary conditions of the human middle ear simple FE model

| Ligaments/Conditions Spring Constant (N/m) | Damping (N-s/m)
Superior mallear ligament Ci1 500 0
Lateral maliear ligament Cc2 400 0
Posterior incudai ligament c3 500 0
Anterior mailear ligament C4 300 0
Posterior stapedial muscie C5 50 0
Cochlear fluid C6 60 0.054
Tensor Tympani tendon Cc7 40 0
Eardrum Support Spring 1.0x10° 0
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Figure 3.10 FE stapes footplate displacement frequency response curve after cycling
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Figure 3.11 FE stapes footplate displacement frequency response curve
after changing the thickness of the eardrum to 0.074 mm
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To further improve the curve, the thickness of the eardrum is uniformly changed to
0.074 mm that is another published data, so that the resulting curve is closer to the

experimental one, as shown in Figure 3.11.
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3.6 Observations And Lessons Learned

Observations and lessons learned from this simple FE model are summarized as
follows:

(1) The frequency response curve of stapes footplate displacement obtained using the
simple FE model is plotted with the 17 LDI experimental curves in Figure 3.12. It is
shown that the FE curve matches the experimental curves very well. However, some
important parameters of the FE model, such as the densities of ossicles and Young’s

modulus of the eardrum are out of the reasonable ranges, as listed in Table 3.3.
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Figure 3.12 Stapes footplate displacement frequency response curves:
FEA prediction and Gan et al. 17 LDI experimental curves (2001)
(2) The stiffness of ligaments or muscles affects the stapes footplate frequency response
curve significantly, especially, in low frequency range.
(3) The Young’s modulus of the eardrum affects the frequency response curve

significantly in all frequency range.
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(4) The effect of damping coefficients was complicated. The stiffness matrix multiplier 8
smoothed the curves in all frequency range. The larger the stiffness matrix multiplier,
the flatter the curve. The damping coefTicient of the cochlear fluid had an important
impact on magnitude of the frequency response curve, especially in high frequencies.

(5) The support elasticity at the eardrum periphery had no significant influence on the
frequency response curve. It is unreasonable in reality though. One possible
explanation is that the membrane element (SHELL 41) employed in modeling the
eardrum makes its periphery so flexible that the additional support elasticity is almost
ineffective.

The simple FE model is successful in supporting the preliminary study of human
middle ear mechanics. With this model, we have not only obtained a valuable FE
modeling experience but also developed a satisfactory method of calibrating the FE
model. In addition, we obtained good results using the simple model. These results help
us better understand the middle ear mechanics.

However, the simple FE model has to be improved to predict the behavior of human
middle ear more accurately. This is particularly because its geometric shape and spatial
arrangement are based on sketch and best possible characteristic geometric dimensions.
Furthermore, the ultrastructure of the eardrum was neglected and a number of main
mechanical properties, such as mass densities, were out of the physiologically reasonable
ranges. Therefore, a new FE model of human middle ear needs to be developed based on
serial histological sections of human temporal bone, which will be presented in the

following chapters.
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CHAPTER FOUR

COMPUTER-AIDED GEOMETRIC MODELING OF

HUMAN MIDDLE EAR

In this chapter, an advanced computer-aided modeling method that supports
engineers to establish accurate 3D geometric and finite element models of human middle
ear is presented. This method combines the traditional histological morphometry study
and the computer-aided geometric modeling and computer-aided design (CAD)
technology. In this method, a set of histological slides is employed for capturing the basic
geometry of the middle ear. Although the magnetic resonance imaging (MRI) and the
computer temography (CT) scans seem to be ideal for this purpose, the resolution for
ordinary CT and MRI is not adequate. Moreover, both methods demand expensive
equipment, the implementation of complex image processing and numerical techniques.

A brief overview of the proposed approach is shown in Figure 4.1. As illustrated in
the figure, the proposed approach includes four stages that will be respectively discussed
in the following four sections. In Section 4.1, the histological section preparation of
human temporal bone, the first stage, will be discussed. Section 4.2 describes the stage of
the scanning and imaging process. The section digitization and the solid model
construction stages are respectively described in Section 4.3 and Section 4.4. Potential

errors induced in various stages are discussed as well.
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| Assembly |

v
Geometric Model of
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Figure 4.1 Computer-aided geometric modeling of human middle ear
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4.1 Histological Section Slide Preparation Of Human Temporal Bone

4.1.1 Decalcifying And Embedding A Temporal Bone

A freshly extracted human temporal bone (female, age 52, right ear) was first
observed under a Zeiss OPMI-1 operating microscope [©*! 255 "1 14 confirm an intact
eardrum and normal ear canal. Then the bone was fixed in aldehyde and decalcified in
10% nitric acid for at least two weeks. The specimen was then run through graded
alcohols to absolute alcohol ethyl for dehydrating. The temporal bone was placed in a jar
with 3% celloidin dissolved in absolute alcohol ethyl. In order to ensure that the celloidin
penetrated into every cavity of the temporal bone, the jar was left uncovered and was
placed in a vacuum bottle on a moving table for a week. And then, the specimen was
transferred to 6% and finally 12% celloidin each for one week. The temporal bone was
allowed to harden slowly by controlled evaporation and finished off with immersion in
chloroform over a two-week period. The resulting block, roughly 25x20x15 mm? in size,

was then removed from the container, trimmed and mounted on a metal chunk and stored

in 70~80% alcohol {1garashi 1964; Donahue & Gussen l9661.

4.1.2 Section Cutting

Before the specimen was cut for histological sections, four parallel fiducial holes
were vertically (from superior to inferior) drilled in the celloidin block surrounding the
middle ear structure. The holes were drilled with the guidance of the holes in a wooden
block placed over the specimen in order to keep them perpendicular to the cutting plane.

Permanent black ink was injected into these holes to color the fiducial marks. The
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specimen was then cut horizontally on an AO 860 sliding microtome

Corporation|]

[American Optical

at a thickness of 20 um for 600 histological sections that were saved in 80%

alcohol. Ilustrations and detailed steps of the cutting setup and procedure are described

in Figures 4.2.

Cutting Setup

M

“@

)
(6)

Level the fixture set of the microtome using
an Empire 360-4 leve] {Empire Level Mg Coml 5 g
tighten the tightening screw.

Mount the celloidin block in the fixture and
make sure its cutting plane is horizontal.
Install a dripping bottle with 70% aicohol on
a frame and adjust the dropping hose to drop
alcohol on the cutting plane of the block for
keeping the block hard.

Adjust the knife stand to clear from the
cutting plane of the celloidin.

Mount the long knife on the knife stand.

Set vertical increment at 20 um on the

microtome and tighten the screw.

Cutting Procedure

0]

@

)

Pull the knife through the block smoothly
and quickly.

Spread out the section.

Put a slide paper with a serial number over
the section.

Slide the section away along the knife blade
and put it in the 70% alcohol with its face
down in a peri-dish.

Store the sections in a covered bottle with

70% alcohol after finishing cutting.

Figure 4.2 Cutting setup and celloidin block cutting




4.1.3 Section Staining
The sliced temporal bone sections, obtained from the procedure described in Figure
4.2, were stained with eosin and hematoxylin in a sequential series of every 10™ section.

The detailed staining setup and procedure are described as in Figure 4.3.

Step#  Solutions for Staining Solution Makeup Purpose  Layover Time
(Second)
| Stilled water Hydrate 15
2 Stilled water Hydrate 15
3 Hemotoxylin (10%) Diluted with stilled water  Stain 30
4 Tap water Rinse 30
5 Alcohol Ethyl (50%) Rinse A few
6 Alcohol Ethyl (50%) Rinse A few
7 Clarifier 70% Alcohol Ethyl A few
+ 10% Acetic
8 Tap water A few
9 Bluing reagent 3 ml Ammonia Hydroxide 30
+ 1 liter tap water
10 Tap water 30
1 Alcohol Ethyl (95%) Ethyl Alcohol - 190 proof 30
12 Eosin (1%) 5 gram Eosin Y Stain 30
+ 500 ml stilled water
13 Alcohol Ethyl (70%) Rinse 30
14 Alcohol Ethyl (100%) Ethyl Alcohol - 200 proof ~ Dehydrate 30
15 Alcohol Ethyl (100%) Ethyl Alcohol - 200 proof  Dehydrate 30
16 Alcohol Ethyt (100%) Ethyl Alcohol - 200 proof  Dehydrate 30
17 100% Alcohol Ethyl Half 100% Alcohol Ethyl 30
+ Chloroform + Half Chloroform
18 100% Alcohol Ethyl Half 100% Alcohol Ethyl 30
+ Chloroform + Half Chloroform
19 @ turpineal Half a turpineal 30
+ histoclear + Half histoclear
20 o turpineal Half a turpineal 30
+ histoclear + Half histoclear

Figure 4.3 The staining setup and procedure
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4.1.4 Slide Mounting

Each stained section was mounted on a glass slide immediately after staining. A total

of 60 slides were obtained, and the anatomical distance between two adjacent slides was

about 0.2 mm. The section mounting follows the procedure shown in Figure 4.4.

@
)
(6)
M
@®

Put a section on a slide (75x50x | mm) tfrom the o turpineal-histoclear
solution and then spread it.

Align and trim the edge of the section.

Blot the section using bibulous paper.

Drop glue (permont) on the section.

Cover the section with a microscope cover glass (45x50x0.1 mm).
Remove the bubbles between the permount and the slide.

Weigh down the slide with two weights for one week.

Store slides in a slide box.

The black ink injected in the fiducial holes for fiducial marks still remained around

the edges of the four fiducial holes on each section after staining and mounting, so that

Figure 4.4 Section mounting procedure

the fiducial marks can be identified in the finished slides.




4.2 Imaging Process

The sixty slides, with the required geometric information of the middle ear enclosed,
were scanned into computer as digital images with a resolution of 1200 pixels per inch.
These images were saved in TIFF (Tag Image File Format), a common image format
widely accepted. Each section image file was named as B plus its section serial number
(for example, B450). Then the middle ear components, including malleus, incus, stapes
and eardrum, were identified and marked on the section images by an otologist, as shown
in Figure 4.5. Before digitizing these images, they were oriented, aligned, stretched and

{Adobe

trimmed in Adobe Photoshop Systems Incorporated] 1, maintain consistency across the

sections by referring to the fiducial marks.

Figure 4.5 A typical section image identified by an otologist

There were three steps involved in the imaging process. First, the section images

were rotated to make the two bottom fiducial marks align horizontally, as shown in
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Figure 4.6. This step ensured that all section images were properly oriented. Second, a
standard template with four fiducial marks (A, B, C, D) was constructed using a typical

section image, as shown in Figure 4.7. Finally, the template was used as the base with

Step 1. Adjustment of Image Orientation

(1) Start Photoshop and choose File>Preferences>Units & Rulers to set the unit to
cm.

(2) Choose File>Preferences>Guides & Grid to set a gridline every 1 cm and 10
subdivisions and turn on ruler and grid.

(3) Import an image into Photoshop and choose Image>Adjust>Brightness/Contrast
to adjust its contrast/brightness to make four fiducial marks (A, B, C, D) clear.

(4) Measure the coordinates of the center of two fiducial marks (A and B) on the
bottom of the image and record them. Then calculate the angle 6 between the
horizontal line and the line joining the centers of these two fiducial marks.

(5) Choose Image>Rotate Canvas>Arbitrary to rotate the image with angle 0 in
order to make the two fiducial marks to lie on the same horizontal line.

(6) Save the image.

(7) Repeat (3) ~ (6) for each image.

Figure 4.6 The orientation of the images
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Step 2. Constructing a Standard Template

(1) Import a carefully oriented section image (for example, B450) into Photoshop as
the base for constructing the standard template.

(2) Choose Layer>New layer to get a new layer and name it “template”.

(3) Activate the template layer. Click Elliptical Marquee Tool and select one of the
four fiducial marks. Choose Select>Modify>Border and type in a width value of
1 pixel. Then click paint bucket tool and fill the highlighted ring area with a
solid color. Go through other three fiducial marks following the same procedure.
By now, there are four small circles to serve as the reference points on the
template.

(4) Click line tool and draw a horizontal line connecting the centers of the two
bottom circles (A and B), and two orthogonal lines through the centers of each
circle. Use these lines as datum lines. The center of A, which is the intersection
point of the horizontal line and the left vertical line, is taken as the datum point
for aligning images.

(5) Duplicate the template layer into a new file named template.

Figure 4.7 The standard template

the referencing datum point for calibrating all the section images, as shown in Figure 4.8.

By aligning the fiducial marks on each section image with those on the template, the
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Step 3. Adjusting Individual Images

)
Q@

3

)

&)

(6)

)

Bring a properly oriented section image into Photoshop.

Activate the template file and choose layer>duplicate layer to duplicate the
template into the new image.

Activate the background and select the center of fiducial mark A as the origin of
this image. Click Move Tool to move the section image to make its origin
coincide with the datum point of the template.

Compare the dimensions and the positions of the fiducial marks on the section
image with the circles on the template. Modify the image to make the fiducial
marks on the section image to match the corresponding circles as accurately as
possible in dimension and position by scaling the new image. The scaling ratio
is determined by the mean stretching rate of the distance of any two fiducial
marks with respect to the corresponding distance of two circles on the template.
Delete the template layer. Click Rectangular Marquee Tool and select a
standard sized rectangle with dimensions 1.2 cmx1.1 cm beginning from the left
top position, which is recorded for all section images.

Choose /mage>Crop to trim the section image as a standard sized image and
save it in bitmap format to obtain a standard sized image file.

Repeat (1) ~ (6) for each section image to obtain the standard sized section

image file.

Figure 4.8 Adjustments of the individual image
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section images were calibrated. They were then trimmed to standard sized images, which

enclose ossicles, eardrum and surrounding structures, as shown in Figure 4.9.

i
b ¥ ~ B Ly
. .l -y

eSS

Figure 4.9 The standard sized section image
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4.3 Section Digitization

After completing the imaging process, sixty standard sized section images were
digitized using SolidWorks, a commercial CAD software. The standard sized section
images were imported into SolidWorks and served as the information source of 2D
geometric contours. The contours of each middle ear component on the section images
were digitized for creating closed curves that characterized the middle ear geometry. The
procedure is described as follows. A reference rectangle was created on the Planel (OXY
plane) of the sketch mode in SolidWorks, as shown in Figure 4.10. Note that this
rectangle was created with the same dimensions as the standard sized image to ensure
that the actual size of the section image can be represented accurately in SolidWorks.
Then sixty sketch planes parallel to planel were created in SolidWorks for digitization.
Note that each section image was imported into SolidWorks on its corresponding sketch
plane. The distance between two adjacent sketch planes was 0.2 mm, which was identical
to the distance between two corresponding adjacent section images extracted from the
temporal bone. The next step was to bring a standard sized section image onto the
corresponding sketch plane, and fit it to the reference rectangle. The 2D contours of the
middle ear components, including eardrum, malleus, incus and stapes, were then digitized
on the sketch plane from the section image. This was carried out by properly marking
points along their boundary using the “Point” option of the sketch mode in SolidWorks,
as shown in Figure 4.10. Finally the image was removed from the sketch plane.

The same procedure was conducted for each standard sized section image. The
digitized contours were saved separately for malleus, incus, stapes and eardrum. Then the

files were used to build the contour curves for the middle ear components separately
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Figure 4.10 Reference rectangle, sketch plane and section contours
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Figure 4.11 Section contours of the middle ear represented by a series of curves
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using the “Spline” option of the sketch mode in SolidWorks. Figure 4.11 shows the
section contours of the malleus represented by a set of serial Spline curves. In this way,
the relative positions among middle ear components were well maintained for final

assembly of the middle ear components. The procedure is summarized in Figure 4.12.

(1) Start SolidWorks and open a new part file. Choose Tools>Options>Grid/Units 1o set
Length Unit as millimeters, Major grid spacing as 10 mm and Minor-lines per major as
10.

(2) Click Plane | and choose /nsert>Sketch. Draw a rectangle with dimensions 12 mmx 11
mm and make the left bottom corner of the rectangle coincide with the origin of the
coordinate system in SolidWorks. Then choose View>Modify>Zoom To Fit to obtain a
standard sized reference rectangle.

(3) Choose Insert>Reference Geometry>Plane>Offset to insert a reference plane parallel
to Plane | for every image and renaming them as Pb plus section serial number (for
example, Pb450). The distance between two adjacent reference planes is 0.2 mm.

(4) Choose Insert>Object to import a section image into SolidWorks. Select the
corresponding reference plane and choose Insert>Sketch.

(5) Move the image to make the left bottom corner of the image coincide with that of the
reference rectangle (origin of the SolidWorks’ coordinate system) and drag the right
top corner until the image fits into the reference rectangle.

(6) Choose Tools>Sketch Entity>point and click (with the Ctrl key pressed) along the
contour of each component on the section image to digitize its boundary by generating
a series of points. Close the sketch and delete the image. Then, rename the sketch as Sb
plus its section number (for example, Sb450).

() Repeat (4) ~ (6) for all the images and save the working file under four different files
named, separately by malleus, incus, stapes and eardrum.

(8) Open file named “malleus” in SolidWorks. Choose Tools>Sketch Entity>spline and
click (with the Ctrl key pressed) on the digitized contour points of the malleus to create
the closed contour curve for each sketch. Then save the file.

(9) Repeat (8) for the files named incus, stapes and eardrum.

Figure 4.12 Detailed procedure for section digitization
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4.4 Solid Model Constructions

Two methods were employed for solid model constructions. The first method utilizes
the “loft” and “doom” features available in SolidWorks to create the initial solid model of
the middle ear. The second method involves curve fitting and surface skinning techniques
that significantly improve the surface quality and geometric accuracy of the solid model.
The second method creates solid models with much smoother surfaces. Both methods use

the same set of discrete points obtained by digitization.

4.4.1 Solid Model Construction By “Loft” And “Doom” Features
The initial solid models were created using the “loft” and “doom” features in
SolidWorks. The “loft” feature creates a solid model, as shown in Figure 4.13 (b), by

connecting multiple closed curves on parallel planes along the plane normal direction, as

7 Doom Added
Doom Added
~rel - . B o N /’;//
. v J P
e L ) Lofted Model
(a) Closed Curves On Parallel Planes (b) Lofting Solid (c) Adding Dooms

Figure 4.13 Solid modei construction using “loft” and “doom™ features
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shown in Figure 4.13 (a). The “doom” feature adds dooms to the flat ends of the solid
model to create smooth closures for the structure, as shown in Figure 4.13 (c). Note that
the “doom” feature is C° -continuous with the rest “loft” feature. Using the “loft” and
“doom” features, the solid models of the middle ear components were first created
separately, as shown in Figure 4.15. Then these component models were assembled to
create the entire middle ear by mating their coordinate systems, as shown in Figure 4.16.

The detailed procedure is summarized in Figure 4.14.

(1) Open the file named malleus. Choose Insert>Base>loft, select the sketches
representing the contours of malleus in a proper order, and click OK to create the solid
model of malleus. Because the shape of each component often changes abruptly from
one section to another section, sweeping through these sections for loft feature may not
be straightforward in SolidWorks. Usually, these closed curves have to be divided into
several overlapping groups for lofting, and some guide curves may be needed.

(2)  Choose Insert>Features>Dome to add a “‘cap” on each end of the solid model and save
the file.

(3) Repeat (1) and (2) for incus, stapes and eardrum.

(4) Open a new assembly file. Choose Insert>Component to bring four components in.

Assemble them by mating their coordinate systems.

Figure 4.14 The procedure of solid model construction
using “loft” and “doom” features
As shown in Figures 4.15 and 4.16, the lofted solid models are not smooth and the
rough surfaces will create difficulties in generating the finite element mesh for structural
analysis. In addition, it is problematic to translate the models from SolidWorks to other
modeling software for creating FE model. The solid model is not quite acceptable and

must be improved by other modeling techniques.
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(b) Incus

(c) Stapes

(d) Eardrum

Figure 4.15 Lofted models

of middle ear components

(a) Anterior View

(b) Isometric View

Figure 4.16 Lofted middle ear solid model
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4.4.2 Solid Model Construction By Curve Fitting And Surface Skinning

To smooth the surfaces of the solid models, we employed the curve fitting and
surface skinning techniques ™" '"®! The same set of discrete points obtained by
digitizing section images of the temporal bone were retrieved from SolidWorks through
its API (Application Protocol Interface). These points were employed for constructing B-
Spline curves and surfaces externally to SolidWorks. These points were grouped by the
individual middle ear components and arranged in sequences at each of the section
images. The curve fitting technique was employed to best fit the geometric points with
closed B-Spline curves on individual sections within a prescribed error bound. The
surface skinning technique was then applied to quilt the series of sections using B-Spline

surfaces. These techniques are briefly described as follows:

Curve Fitting Technique

The curve fitting technique employs the least square fitting for the given geometric
points on a pre-selected section of an object. The best fitting curve can be obtained by
minimizing the distance sum between the curve and the geometric points. The distance

sum fis defined as

f =io ”PJ -x(ul)“- @.1)

where P; is the position vector of the j™ geometry point, and r+/ is the total number of
geometric points of the contour; |je]| is the norm of the vector e; x(u) is the fitting B-
Spline curve; x(u,) =[x,(u,),x,(u,),x;(u,)] is the position vector of the fitting B-Spline

curve at u;, where u is the parametric coordinate of the curve. The u; in Eq.(4.1) is defined
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by the length ratio of the polygon formed by the geometric points P;, as illustrated in

Figure 4.17(a). Mathematically, the values of #; can be calculated by

1=l r
“0 = 0’ ll, = (r+ l)ZIP(hl)mod(Nl) - Plr I/le(k»l)mod(nl) -Pkl’ (.I = I! I') (4.2)
k=0 k=0
and the B-Spline curve is defined as,
()= B, N, () 4.3)
1=0

where B; is the i control point shown in Figure 4.17(b), n+1 is the number of control

points, and N, (u) is the basis function of the B-Spline curve defined recursively as

N,W)= 4.4)

tia =1, Lo =l N, ,()=0,  otherwise

(u _’I)Nl.k-| (u) + ('u-k_“)Nul.k-l(u) . {Nl.l(u) = l’ 'l sus ’nl

where [t t;+/) is a knot span formed by the two consecutive knots ¢, and ¢,.,, and k-1 is
the polynomial order of the basis functions Moo 19831,
In order to minimize f, the derivatives of f with respect to the n+/ control points are

set to zero. For simplicity, considering only the ™ control point, one has

&
dBI =0

-2P ZN,k(zl )+2ZN,k(u ) ZN,k(u )B, “ : (4.5)

For ¢ = 0, n, the above expression can be rewritten in a matrix form as
N'NB=N'P (4.6)

where N R”*) B = R™™ P =R, and

Nox(ug) Nip(ug) -+ N, (ug)

N = No,k:(“l) Nl,ft.(ul) Nn,k:(ul) @7

NO,k(ur) Nl.k(ur) Nn,k(ur)

(r+l)x(n+1)
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Polygon of Control Points
(Control Polygon)

(b) B-Spline curve with control points B,

Figure 4.17 B-Spline curve fitting
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Note that N'N is invertible if N, (u,)#0 PP | This is true if and only if
g <u,<t,,fori=0,n;and j=0,r. This implies that there must exist at least one
u; in at least one knot span so that N, (u,) # 0 for all basis functions. This requirement

can be achieved by adjusting the knot values of the basis functions. The curve fitting
error can be controlled by adjusting the polynomial order and the number of control
points. The output of the curve fitting is a set of control points and basis functions that
describe the smoothed section contour. The computational algorithm of B-Spline curve

fitting is summarized in Figure 4.18.

(1) Collect and sort geometric points;

(2) Smooth geometric points by averaging their positions with two previous and two
following nodes (optional);

(3) Specify desired error bound ¢;

(4) Determine polynomial order;

(5) Determine number of control points, n+/, as small as possible;

(6) Construct the B-Spline curve, reduce fitting error by adjusting u, values using the
chord length parameterization method;

(7) Calculate e = f/(r+1), if e <g acquire control points B, to construct B-Spline curve;

(8) Otherwise, increase & or n, repeat steps 4 to 7.

Figure 4.18 The computational algorithm of B-Spline curve fitting

Surface Skinning

The fitting B-Spline curves discussed above are then related across sections to form
an open B-Spline surface, as shown in Figure 4.19, using the surface skinning technique.
Note that in this process, the number of control points of the B-Spline curves must be

kept identical across all the sections. In addition, the polynomial order of the basis



functions and knot values of the B-Spline curves must be identical on all sections. The
control points are connected to their corresponding points across sections, as shown in
Figure 4.19(a), to form a control polyhedron. The enclosed B-Spline surface is then

constructed, as shown in Figure 4.19(b), by

”" m

x(“’ w) = ZZB”N“‘ (“) 1"!,1(“’)9 (4.8)

1=0 ;=0
where n+/ and m+! are the numbers of control points in the u- and w-parametric

directions, respectively; and K-/ and ¢-/ are the polynomial orders of the basis functions
N,,() and M (w), respectively. Note that the B-Spline surface constructed is C-

continuous in both - and w-parametric directions, if cubic basis functions are assumed.
End caps can be generated by introducing additional control points on the end face of the
control polyhedron. More than one control points can be added to the end face and each
of them can be adjusted individually to best fit the geometry of the structure. Note that
the C’-continuity is maintained between the cap and the flat end face if a bi-cubic B-

Spline surface is employed. This is the main reason why the surface skinning method can

produce much smoother models. The control points, B, , and basis functions, N, (u)

y?
and M ,(w), of the B-Spline surface can be imported back to CAD tools to support solid

modeling. The computational algorithm of the B-Spline surface skinning technique is
summarized in Figure 4.20.

After the closed B-Spline surfaces that represented the geometric boundary of each
middle ear component were constructed using the curve fitting and the surface skinning
techniques, they were then respectively imported into SolidWorks by using the APL In

SolidWorks, the smooth solid models of the middie ear components were generated using



(b) B-Spline surface enclosed by the control polyhedron

Figure 4.19 B-Spline surface skinning
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Define the longitudinal direction (w-direction) and identify parallel sections along
the direction;

Acquire and sort the geometric points on each section;

Find the section with the most complex geometric contour manually and construct a
B-Spline curve to fit the geometric points using the curve fitting method;

Obtain the minimum number of control points that describe the most complex
section for a given error bound, and use it as the common number of control points
for the rest of the sections;

With the number of geometric points r+/, basis function order £-/, and common

number of control points n+/ available for the j/ section, use the chord length

parameterization method to determine U’ =[uy,4), -, u,] and, subsequently, the

knot vector 7,/ . This procedure is repeated for the rest of the sections:

Average the knot values of the corresponding knots across all sections for a
common knot vector 7, ;

Generate B-Spline curves with the basis function order k-/, control point number
n+/ and common knot vector 7, to fit the geometric points of each section;

While performing curve fitting for each section, check the curve fitting error. If
there is a section with an error that exceeds the error bound specified, define it as
the section with the most complex geometric contour and repeat steps 3 to 8, until
the maximum curve error is less than the desired limit €;

Construct the common basis function for the u-parametric direction, N, ; (u):

Calculate the knot vectors T, of the #** row in the w-parametric direction based on

the control points obtained in step 8, use the knot value placement suggested by

Rogers er af. IRos=rs /<t 19| “hyis process is repeated for all rows.
Similar to 7, , the common knot vector 7, in the w-parametric direction is

determined using the same averaging scheme as step 6.

Construct the common basis functions for the w-parametric direction, M, ,(w):

Acquire control points B; and basis functions of the B-Spline surface, and

construct the B-Spline surface.

Figure 4.20 The computational algorithm of
B-Spline surface skinning technique




the “thicken” feature. The “thicken” feature creates a solid model by thickening a surface
or knitting a closed surface. Finally, these component models were assembled into the
smooth middle ear model by mating their coordinate systems. Because these coordinate
systems were copied from the same coordinate system used for section digitization, the
assembly ensured that the components were properly positioned and oriented.

The refined middle ear solid models using the curve fitting and surface skinning
techniques are shown in Figures 4.21 and 4.22. Figure 4.21 shows four middle ear
components constructed. Figure 4.22 shows the assembled middle ear model in anterior
view and isometric view. In comparison with the models shown in Figures 4.15 and 4.16,
the quality of the surfaces of the refined model was significantly improved. The smooth
model is not only closer to the real representation of the biostructure, but also facilitates
translating the model from SolidWorks to other modeling tools for finite element mesh
generation.

In SolidWorks, the solid model of middle ear can be easily manipulated for 3D
visualization. Geometric dimensions can also be easily verified by measuring the middle
ear solid model. The characteristic dimensions of the model were measured in
SolidWorks and are well within the ranges of published data listed in Table 4.1. The
result in Table 4.1 shows that the geometric model created by the proposed method is

very accurate.
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Malleus Incus

Stapes Eardrum

Figure 4.21 Smooth model of middle ear components

(a) Anterior View (b) Isometric View

Figure 4.22 Smooth model of middle ear
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Table 4.1 Comparison of geometric characteristics between

the CAD model and published data

[CAD Model Data _[Published Data_|Published Data References

18.76 mm lsr.0~10.0 mm Gray 1918 *
Diameter perpendcular to manubrium[8.93 mm 7.5~9.0 mm Helmholtz 1863 *
1.46 mm 1.54 mm Wada et al. 1992
2.00mm Siebenmann 1897 *
166.30 mm* 65.8~85.0 mm* Wever et al. 1954, Keith 1918 °,
von Békésy 1941°
0.05~0.074 mm 0.1 mm Heimholtz 1863 *
0.04~0.075 mm Kirikae 1960
0.132 mm Wada et al. 1992
Length from end of manubrium 4.20 mm 5.8 mm Stuhiman 1937 *
to end of (ateral process
r7.65 mm 7.6~9.1 mm Bast & Anson 1949 *
J33.94 mg 23~27 mg Stuhiman 1937 *, Wever et al. 1954
Length along long process 6.08 mm i'7'.() mm Stuhiman 1937 *
Length along short process 4.49 mm 5.0 mm Stuhiman 1937 *
i 24.77 mg 25~32 mq Stuhiman 1937 *, Wever et al. 1954
2.87 mm 2.5~4.0 mm Stuhiman 1937 *, Wever et al. 1954
Length of footpiate 2.5mm 2.64~3.36 mm Wever et al. 1954
2.5 mm Our Measurement
idth of footplate 1.38 mm 0.7~1.66 mm Helmholtz 1863 *, Wever ot al. 1954
eight |2f'2‘ mg +21)5-4.35 mg Wever ot al. 1954

* The work was done by the listed authors but the data came from Wever & Lawrence’s book [Wever & Lawrence 1954
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4.5 Physical Middle Ear Model Fabricated By Rapid Prototyping

One major advantage of constructing a CAD solid model of the middle ear, instead
of an FEA model first, is that the middle ear constructed in solid model can be fabricated
for physical models directly using the rapid prototyping technique. Rapid prototyping is a
fabrication technology that replicates physical prototypes of objects from their virtual
mockup. The main advantage of rapid prototyping is that a physical model is built
directly from the solid model, instead of employing the traditional manufacturing
process. In all rapid prototyping processes, physical models are fabricated layer by layer
[Jacobs 1994] "The model is mostly used for geometric verification, tooling, and for an early
marketing investigation. Sometimes it can be used for function checking when high
strength material such as Nylon and Polycarbonate is used.

As a general procedure, a CAD solid model is exported into a file format that
describes the geometric boundary of the solid model by trianglar facets, such as an STL
(Stereolithography) file V> "% The faceted representation describes the approximate
geometry of the solid model. In SolidWorks, the level of the approximation can be
adjusted by using different quality setting. The quality setting controls the total number of
the triangles in the facet approximation by adjusting the chord height deviation and the
angle tolerance between the actual model surface and the triangle facets. The STL file is
transferred into a slicing software, which converts the STL file into a slice-by-slice
format so that the rapid prototyping machine can accept and process. The sliced model
file is processed by the rapid prototyping machine to fabricate a physical prototype. The
physical prototype is then fabricated and cured.

In this research, the physical model of human middle ear was fabricated using an
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SLA-7000 from 3D System, Co. 1°P $*™l 3 ranid prototyping machine as shown in
Figure 4.23 (c). The CAD model of human middle ear was exported as a STL file from
SolidWorks. The file includes about 390,000 facets. The STL model was then sliced by
Buildstation °P 3™l 3 software tool developed by 3D Systems, Co. The sliced STL file
was sent to SLA-7000 and then the physical model was fabricated. The procedure is
briefly shown in Figure 4.23. The physical model, as shown in Figure 4.23 (d), is pretty
smooth. The model can be used for geometric verification, education, and surgical
rehearsal.

By using high strength building materials, the CAD model may also be used for

producing anatomically shaped prostheses through the rapid prototyping technique.

(c) SLA-7000 (d) Physical Model

Figure 4.23 Fabrication of physical middle ear
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4.6 Discussions

4.6.1 Potential Geometric Modeling Errors

We note that possible errors in the solid model mainly come from the histological
section preparations (Stage 1 shown in Figure 4.1). The errors induced in the stage can be
categorized into method errors and operational errors. The method errors include those
induced by variations in thickness, the shrinkage, tearing, folding and wrinkle of the
section issues. The variations in thickness can be alleviated by adjusting the hardness of
the celloidin block and the shrinkage can be corrected by estimating the shrinking rate.
The tearing, folding and wrinkle on some sections are inevitable, but the problem can be
solved by substituting the damaged section by its adjacent good section and adjusting the
distance from the previous layer.

The operational errors are due to inconsistency of different operators (operator
inconsistency), different shrinking rate of sections and inconsistent setup if the celloidin
block is cut at different time (time inconsistency), incomplete record of damaged
sections, and damaged or missing fiducial marks. The operator inconsistency can be
minimized by having one operator to work on the entire process. The time inconsistency
can be avoided by finishing section cutting in one day. Other operational errors may be
minimized or eliminated by operating carefully and keeping a good experimental record.

One other possible error may also come from the section imaging process (Stage 2
shown in Figure 4.1) while determining the center location of the fiducial mark. But it
can be minimized by carefully adjusting the images; that is, carefully identifying and

measuring the center of each fiducial mark. Because the computer-integrated section



digitization and solid model construction is systematic and less error-prone, we believe
that the reconstructed solid model is very accurate if only the temporal bone sections are
obtained consistently. This has been shown by the geometric dimensions of the

constructed middle ear model comparing with those published.

4.6.2 Advantages of The Geometric Modeling Method

The proposed geometric modeling method provides researchers with a systematic
and practical approach to accurately capture middle ear geometry for constructing 3D
computer models. This method is accurate, systematic, low cost, and general.

This method retains the accuracy of the middle ear anatomy by employing
histological section images obtained by slicing human temporal bones. The systematic
imaging process aligns, orients, and resizes the section images to minimize mismatch of
component contours due to inevitable operation errors. Furthermore, the error control
scheme employed in the curve fitting for image contours ensures that the reconstructed
geometry can be close to the real middle ear structure within a prescribed error range.
The accuracy of the proposed method has been demonstrated, as shown in Table 4.1.

This method is systematic. As presented in Figure 4.1, this method follows a
prescribed procedure. The standardized procedure makes the method easy to follow and
eliminates potential inconsistency and mistakes. In addition, the required software tools
are operating system independent and less demanding on computing resources. The
computing environment can be easily created to support the modeling work using the
proposed method.

The proposed method is low cost, as compared with possible alternatives such as

CT, MRI or laser scans with comparable accuracy. The laboratory setup that is required
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for supporting temporal bone slide preparations, as described in stage 1 of Figure 1, is
very common in any bioengineering laboratory. A regular scanner, HP ScanJet Scanner
(Hewlen-Packard] a5 employed for scanning the slide images into computer with required
accuracy and resolutions. Software tools that support imaging process, image digitizing,
and geometric modeling are industrial standard, off-the-shell tools. The only special tool
employed in the method is the curve fitting and surface skinning that is developed
separately by our research team.

Most importantly, the proposed method is general. It is applicable to structures with
complicate geometry, various topology, and different physical sizes. This method works
especially well with small-size structure and complicate geometry like the human middle
ear.

Furthermore, the method opens up many research possibilities that require further
anatomic and pathologic information about the function of complex and tiny
biostructures. The solid geometric model of human middle ear has been proven to be a
good basis for finite element analysis of human middle ear. It also provides a possible

way to fabricate the middle ear prostheses with accurate geometry, as shown in the

physical model in section 4.5.
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CHAPTER FIVE

COMPUTER INTEGRATED FINITE ELEMENT

MODELING OF HUMAN MIDDLE EAR

In this chapter, a procedure of constructing the FE model of the middle ear is
presented. The finite element mesh of the middle ear was first generated based on the
refined middle ear solid model obtained from Chapter 4. Then the material properties
were assigned to individual parts of the system. Most material properties came from
published data as reviewed in Chapter 3. The remaining material properties were
assumed partially based on engineering reasoning, partially through the modeling
practice in Chapter 3 and partially by the FE model calibration process. The finalized FE
model was verified by comparing the FE model prediction with published experimental
measurements. The objective is to construct a FE model as the base-line FE model for
clinical-related applications. The FE model includes malleus, incus, stapes, eardrum,
joints, ligaments, muscles and cochlear impedance. The middle ear cavity was not
included in this model because it is shown that the middle ear cavity does not contribute
significantly to the normal middle ear mechanics V"™ 2nd Feenstra 1986] 11y iher words, the
“acoustic coupling” is assumed not playing a significant role in sound transmission in
normal middle ear. And this assumption is also consistent to an experimental setup, in

which the middle ear cavity is open.
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5.1 Mesh Generation For The Middle Ear FE Model

To prepare for the finite element analysis of middle ear mechanics, all surfaces of the
refined solid model were translated into HyperMesh via ACIS format 5P 0Pl The
surfaces translated into HyperMesh are shown in Figure 5.1. Based on these surfaces, the
finite element mesh of the middle ear was created by means of both automatic and
manual meshing capabilities in HyperMesh. A total of 1,746 3-noded triangular and 4-
noded quadrilateral shell elements (SHELL 63) were created to mesh the eardrum, which
yielded a resolution of 25 elements/mm?’ in average. The mesh of eardrum includes 1,561
nodes with 9,366 degrees of freedom. Surrounding the eardrum periphery, the tympanic
ring was meshed using 113 3-noded triangular and 4-noded quadrilateral shell elements.
There were 812 8-noded hexahedral, 6-noded pentahedral and 4-noded tetrahedral solid

elements (SOLID 45) created to mesh ossicles. joints. ligaments and muscles with an

(a) Anterior View (b) Isometric View
Figure 5.1 Surface model of human middle ear in HyperMesh

average resolution of 45 elements/mm’. The total number of nodes was 1,497, and
therefore the total number of degrees of freedom was 4,491. Lying in the stapes footplate

plane, there were 25 spring elements (COMBIN 14) employed to model the stapedius
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annular ligament. A total of 49 spring-damper elements perpendicular to the footplate
plane were employed to model the cochlear fluid. The size of the model is adequate for
an accurate FE analysis with a reasonable computation time. Figure 5.2 (a), (b) and (c)

show the middle ear FE mesh in anterior, superior and isometric view, respectively.

cus Am?u gl"fl’g:mem

2 Stapedius
_ Annulir”figament

M Periphery

(c) Isometric View

(b) Superior View

Figure 5.2 Finite element mesh of human middle ear
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5.2 FE Modeling Considerations

The anatomy and functions of the middle ear discussed in Section 3.1 were
incorporated into the FE modeling. The modeling considerations were realized in the FE
model by assigning different material properties to different parts of the middle ear
system. Most material properties came from published data reviewed in Chapter 3. The
remaining material properties were assumed partially based on engineering reasoning,
partially through the modeling practice in Chapter 3 and partially by the FE model
calibration process.

The Poisson’s ratio was assumed 0.3 for all materials of the middle ear system based
on the fact that all published Poisson’s ratios are close to this value. In addition, there is
no evidence showing significant effects of Poisson’s ratio on dynamic behaviors of the
middle ear system [Fume!! & Laszlo 1982) he oublished stiffness and density were used for
main components of the middle ear, including malleus, incus, stapes and eardrum.
Ligaments, muscles, malleus attachment on the eardrum, incudostapedial joint and
tympanic ring were assumed the same density as that of the eardrum. Five of six
ligaments and muscles, including superior malleus and incus ligaments, lateral malleus,
posterior incus, the posterior stapedial muscle and the tensor tympani muscle, and
incudostapedial joint were assigned the published stiffness data. The stiffness of
incudomalleolar joint was assumed by reasoning based on the published experimental
observations. The stiffness of the anterior malleus ligament (C4 in Figure 5.2) and the
tympanic ring were adjusted and finalized by the FE model calibration process, as
described in Chapter 3. The damping coefficients for all the parts of the middle ear

system were selected based on the study of the simple model presented in Chapter 3.



The detailed modeling considerations incorporated for the main middle ear
components, joints, attachment, ligaments, muscles and tympanic ring are introduced in

the following subsections.

5.2.1 Material Properties Of Middle Ear Components

Eardrum

The eardrum ultrastructure study {Lim 1968 & 1970; Shimada and Lim 1971)

shows the regularity
of the radial and circumferential fibers appearing in the pars tensa. The analytical studies
by Rabbitt and Holmes (R and Holmes 1986] 514 indicate the importance of anisotropic
material properties of the eardrum. The eardrum in this FE model was modeled as a linear
elastic shell structure with homogeneous and orthotropic material properties. The shell
element (SHELL 63) was employed instead of the membrane element (SHELL 41) so
that the elastic support effect of the eardrum periphery could be incorporated (unlike the

problem encountered in the simple model in Chapter 3). Based on the review of Section

3.3, the material of the eardrum was assumed to have circumferential Young’s modulus
of 2.0x10" N/m* in the pars tensa and 1.0x10’ N/m? in the parsa flaccida, and radial

Young’s modulus of 3.2x10’ N/m* in the pars tensa and 1.0x10" N/m’ in the pars
flaccida, respectively. The annular ligament, which divides the eardrum into pars tensa
and pars flaccida, was assumed to have the same Young’s modulus as the pars tensa. The
consideration reflects the ultrastructural chacteristics of the eardrum [Arson and Donaldson [981:
Rabbitt and Holmes 1986}

, as shown in Figure 5.3. The thickness varied in accordance with the

eardrum geometry obtained in the CAD solid model.
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Figure 5.3 Eardrum FE model in medial view

Ossicles

The ossicles were modeled as linear elastic and isotropic structure. The homogenous
Young’s modulus 1.4x10" N/m® was employed. Based on the work of Kirikae "
1% the mass densities varied in different portions of the ossicles, which are listed in
Table 3.2. Although some research shows that there exists certain relationship between
the Young’s modulus of a material and its density, the relation was not considered in this

research due to lack of experimental data.

Malleus Attachment on the Eardrum

The malleus attachment on the eardrum, as shown in Figure 5.4, was modeled as

linear elastic, homogeneous and isotropic hard tissue. The attachment is softer than
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Figure 5.4 Malleus attachment on the eardrum,
incudomalleolar joint and incudostapedial joint

ossicles because the manubrium is not tightly attached to eardrum in human temporal
bone [CGraham ¢t al 1978] Tharafore, Young’s modulus of the attachment was assumed one

third of that of the ossicles to simulate the “softer” effect.

Incudomalleolar Joint

The incudomalleolar joint is shown in Figure 5.4. Studies on auditory physiology and
sound transmission through human ear have suggested that the incudomalleolar joint is
relatively rigid at physiological sound pressure levels for frequencies below 3000 Hz
[Guinan and Peake 1967. Viaming 1987] Thyis means that there is no relative motion between malleus
and incus in the low frequency range. It may not be the case in the high frequency range

or high sound pressure amplitude. Therefore, the incudomalleolar joint was modeled as



homogeneous and isotropic hard tissue with a Young’s modulus identical to the ossicles.

Incudostapedial Joint

The incudostapedial joint, as shown in Figure 5.4, appears to be non-rigid [Hontrink

'8 That is, there is a relative motion between incus and stapes. So the joint was

modeled as homogeneous and isotropic ligamentous tissue [Femis & Prendergast 2000] ppe

Young’s modulus was assumed as 6.0x10° N/m*, which was reported by Wada e al.

[Wada et al. 1996]

The damping coefficients for all the middle ear components were assumed to be
a=0s",8=00001s, based on the study of the simple model in Chapter 3. The malleus

attachment on the eardrum, incudomalleolar joint and incudostapedial joint, which
consist of the solid elements as described in Section 5.1, connect malleus and eardrum,
malleus and incus, and incus and stapes by coupling the corresponding finite element
nodes among them. The material data used for the middle ear FE model and their sources

are summarized in Table 5.1.

5.2.2 Boundary Conditions

Figure 5.2 illustrates the boundary conditions employed in the FE model. As shown
in this figure, three ossicles (malleus, incus, and stapes) were held at the eardrum by the
malleus, and at the oval window by the stapes footplate. The ossicles were also supported
by suspensory ligaments and intra-aural muscles. Four major suspensory ligaments
(superior malleus and incus, lateral malleus, posterior incus, and anterior malleus), the

posterior stapedial muscle and the tensor tympani muscle were regarded as clastic



Table 5.1 Material properties of middle ear components used for the FE model

EARDRUM |Data Used for FE Model Source
Density (kg/m”) 1.2x10° Williams et al. 1990
Wada et al. 1990, 1992, Beer ot al. 1996
|Ferris ot al. 2000,
'%ung's Modulus (N/m°)
pars tensa|2.0x10’ (circumferential) Beer of al. 1996
3.2x10’ (radial)
pars flaccida|1.0x10 (circumferential) Prendergast, Ferris et al. 1999
1.0x10’ (radial)
Damping a=0s", $=0.0001s Chapter 3 of this dissertation
MALLEUS
Density (kg/im’) 2.55x10" (for head) Kirikae ef al. 1960, Wada et al. 1992
4.53x10" (for neck)
3.70x10° (for handie)
[Young's Modulus (N'm?) 1.41x10° Kirikae of al. 1960, Herrmann et al. 1972
Koike 1996, Wada et al. 1992, 1996
Prendergast et a/. 1999
'mUS
Density (kg/m°) 2.36x10° (for body) Kirikae et al. 1960, Wada et al. 1992
2.26x10° (for short pracess)
5.08x10:6Lfm long process)
'Young's Modulus (N/m®) 1.41x10 Kirikae et al. 1960, Herrmann et al. 1972
Koike 1996, Wada et al. 1992, 1996
Prendergast et al. 1399
Damping a=0s", $=0.0001s Chapter 3 of this dissertation
2.20x10° |Kinkae 1960
1.41x10° Kirikae ef al. 1960, Herrmann ef al. 1972 |
Koike 1996, Wada et al. 1992, 1996
Prendergast et a/. 1999
a=0s”, $=0.0001s Chapter 3 of this dissertation
3.2x10°
1.41x10"7
a=0s", $=0.0001s Chapter 3 of this dissertation
INCUDOSTAPEDIAL JOINT
Density (kg/m°) 1.2x10°
Young's Modulus (N/m°) 6.0x10° N/m* Wada et al. 1996, Prendergast 1999
iFerris et al. 2000
Dampin, a=0s’. §=0.0001s Chapter 3 of this dissertation
MALLEUS ATTACHMENT
ON THE EARDRUM
Density (kg/m’) 1.0x10°
Young's Modulus (N/m®) 4.7x10"_
Dampin a=0s", p=0.0001 s Chapter 3 of this dissertation

constraints, C1~CS5, C7, respectively. The tympanic ring was modeled as an elastic ring

that connects the eardrum periphery and the bony wall of the ear canal. The cochlear fluid

was assumed a viscoelastic constraint, C6. The detailed modeling considerations are

described as follows.
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Ligaments and Muscles

The ligaments and muscles, including the superior, anterior and lateral ligaments of
malleus, the posterior ligament of incus, the tensor tympani muscle, the posterior
stapedial muscle, (shown in Figure 5.2) were modeled as homogeneous, isotropic
ligamentous tissue using solid elements as described in Section 5.1. As listed in Table
5.2, the Young’s moduli of all ligaments and muscles were chosen based on the review in
Section 3.3 except the anterior mallear ligament (C4 in Figure 5.2). The published
Young’s modulus for the anterior mallear ligament was not used in the FE model because
it differs significantly from rest of the ligaments. The consideration was based on the
assumption that the materials having similar histological structures should have similar
mechanical properties. The value of C4’s Young’s modulus was adjusted and finalized

through the FE model calibration process. The damping parameters for all ligaments and
muscles were assumed to be a=0s",8=00001s based on the study of the simple

model in Chapter 3. Each ligament or muscle was attached to the ossicles by coupling

corresponding finite element nodes among them at one end, and fixed at the other.

Table 5.2 Initial boundary conditions used for the FE model

| Young's Modulus or Spring Constant Damping _
Superior maliear ligament (C1) 4.9x10° N/m* (Beer et al. 1996)
Lateral mallear ligament (C2) | 6.7x10° N/m® (Beer et al. 1996) a=0s", $=0.0001s

| Posterior incudal ligament (C3) | 6.5x10° N/m® (Wada et al. 1996,

Prendergast et a/. 1999, Ferris et a/. 2000)

Anterior mallear ligament (C4) 2.1x10" Nim® (Wada et al. 1996,

| Prendergast et al. 1999, Ferris ot al. 2000)
Posterior stapedial muscie (C5) | 5.2x10° N/m® (Wada et al. 1596,

_7 Prendergast et a/. 1939, Ferris et al. 2000)
Tensor tympani muscie (C7) 2.6x10" N/m‘ (Wada et al. 1996, Prendergast et a/. 1999)

Cochiear fluid (C6) 60 N/m (Chapter 3 of this dissertation) _ 0.054 N-s/m
| Stapedius annular ligament 9 N/m (Converted from Lynch et al. 1982) 0 N-s/m
Tympanic fing 3.2x10'N/m° a=0s’. 3=0.0001 s
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Tympanic Ring

To simulate the flexible support at the eardrum periphery '™ '°”°!_ the tympanic ring
was modeled as an elastic ring of 0.2 mm width and 0.2 mm thick using shell elements, as
described in Section 5.1. The ring was connected to the eardrum periphery at the inner
edge by coupling corresponding nodes and was constrained against translational
movements at the outer edge, as shown in Figure 5.3. The constraint consideration was
based on Williams er al.’s study [Viltams ef ol 1996b] e Young’s modulus was initially
assumed identical to the eardrum, and then adjusted in the FE model calibration process.
To consider the effect of the missing part of the ring, notch of Rivinus, the Young’s
modulus of the part corresponding to the notch of Rivinus, was assumed one third of that
of the ring. The damping coefficients for the tympanic ring were assumed to be identical

to the eardrum.

Stapedius Annular Ligament

The in-plane stiffness action on the stapes footplate due to the stapedius annular
ligament was represented by 25 linear spring elements distributed evenly around the side
periphery of the footplate, as shown in Figure 5.5. These springs are perpendicular to the
side periphery of the footplate. Each spring was attached to the corresponding node of the
side periphery of the footplate at one end, and fixed at the other, to simulate the
attachment to the margin of vestibular fenestra. The arrangement replicates the fact that
the stapedius annular ligament restrains mainly against in-plane motion of the footplate.
The out-of-plane stiffness was combined into the consideration for the stiffness induced

by the cochlear impedance. Assuming that the material of the stapedius annular ligament
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Stapes Foaplate % |/

Side Periphery |

K ) ] 1 i
AN 25 Springs To Simulate
Stapedius Annular Ligament

Figure 5.5 Stapedius annular ligament

is homogenous, isotropic and uniformly distributed surrounding the side periphery,
Lynch er al. estimated the Young’s modulus of the stapedius annular ligament to be
1.0x10° N/ m? Tncheral 1982) Baced on Lynch ef al.’s assumption, the stapedius annular
ligament can be considered as a slab surrounding the side periphery of the footplate. The
thickness of the slab was estimated as 0.05 mm by measuring the average space between
the side periphery of the footplate and the wall of the oval window on the histological
sections of human temporal bone. The area of the side periphery of the footplate was
measured as 1.275 mm* using the middle ear FE model. If the slab is uniformly divided
into 25 segments along the side periphery of the footplate, then each segment can be
treated as a bar element perpendicular to the periphery of the footplate. Therefore, each
bar has a cross-section area of 0.051mm’ and a length of 0.05mm. Based on the

discussion above, the spring constant for each spring was estimated as 9.0 N /m.
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Cochlear Fluid Impedance

Some researchers considered cochlear fluid impedance to be resistive and expressed

[Wada er al. 1996; Femis et al. 2000] jp their FE models. The damping

it as a viscous damping
coefficients were estimated using the acoustic input impedance of the cochlea that was
calculated from measurements of the stapes displacements. In another paper, Wada er al.
modeled the cochlear impedance as a set of springs perpendicular to the plane of the
footplate "2 ¢4 19921 However, they did not give the spring constant for normal ears. In
Funnell er al. and Ladak er al.’s FE models, the action of cochlear fluid and stapedial
annular ligament on the stapes footplate was also considered as stiffness perpendicular to
the plane of the footplate [Funnell ¢t af. 1978: Ladak et al. 1996] ‘The riffness was estimated at a
specific frequency using the acoustic impedance or acoustic compliance of the cochlea
that were calculated from measurements. In our FE model, the action of the cochlear fluid
on the stapes footplate was modeled as a set of 49 linear springs with dashpots (damping)

distributed on the footplate, as shown in Figure 5.6. Note that these springs and dashpots

are oriented in the normal direction of the footplate plane.

Stapes Footplate

49 Springs with Dashpots
to Simulate Cochlear Fluid

Figure 5.6 Cochlear fluid
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In order to understand how to estimate the total damping coefficient and stiffness of
the cochlea from the published acoustic impedance data, we consider that the cochlea is
uncoiled and is simplified as shown in Figure 5.7 (a). The cochlea appears as a tapered
cylinder divided into two sections, scala vestibuli and scala tympani, by basilar
membrane. Note that we ignore the cochlear duct because it is quite thin compared to the
scala vestibuli and scala tympani. At the larger end of the cylinder are the oval window
and the round window, each of which is closed by a thin membrane. Near the far end of
the basilar membrane is a small hole called the helicotrma connecting the two sections.
Therefore, the fluid in scala vestibuli and scala tympani can be simplified as a one
dimensional mechanical system that consists of a mass block with mass m, a spring with
spring constant & and a dashpot with damping coefficient ¢, as shown in Figure 5.7 (b).
When the system is stimulated by a sinusoidal force F, the equation of motion of the

system is

—lx

(a) Uncoiled and Simplified Cochlea (b) One Dimensional Mechanical
Model

Figurc 5.7 Uncoiled cochlea and one dimensional mechanical model of cochlear fluid
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mi+ck+ke=F é.1)
Since F is a sinusoidal function, then the displacement x can be expressed as

x = Xe" (5.2)

where i =v-1 , @ is the angular frequency and X is the amplitude of the displacement x.
Therefore, we have
x=-i¥/0 , ¥=iox (5.3)

By substituting Eq.(5.3) into Eq.(5.1), the mechanical impedance of the system, Z,, can
be obtained as

Z =F/x=c+i(om-k/w) (5:4)
Assuming the area of stapes footplate is 4 and the pressure is uniform over the stapes
footplate, then the volume velocity of the cochlea is %4 and the pressure is F/ A. Based
on the definition of the acoustic impedance Z,, which is the pressure divided by volume
velocity, we have

_Fl4_c+i(lom-k/o) (5.5)

Z,
x4 4°

Therefore the magnitude |Z,| and phase angle £Z,of the acoustic impedance are

respectively obtained as
2 2 - - 5.6
2= [ s @m-kia) . £Z, =" OmK/0 (6)
A c
Solving Eq.(5.6) gives
c=A%|Z,|elcos<Z,| , k=v(om-ctanlZ,) (5.7)

where o =2af and f'is the frequency. The mass m can be estimated by halving the total

mass of the fluid in scala vestibuli and scala tympani. The k and ¢ can be determined
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using the cochlear input impedance curves obtained experimentally A et al- 2000]

Igarashi et al.’s study shows that the volume of scala vestibuli and scala tympani are
respectively 3.15x10°m* and 4.43x 107 m?* Veerashi eral 19861 A gqume the density of the

fluid to be the same as the density of water, i.e.,1x10°kg/m’; then we can estimate

m=3.79%x10" kg . From our middle ear model, we have 4 =2.91x10°m’. The mean

experimental curves of the cochlea input impedance published by Aibara er al., as shown

[Aibara et al. 2000}

in Figure 5.8 , were employed to estimate the stiffness and damping

coefficient from Eq.(5.7).

P | i A Aebndradbesbndnds A e

Mean of 12 Temporal Bones
Each of 12 Temporal Bones

3

Magnitude (G MKS)

-
e
A

Cochiear Input Imedance Za

.1804 Sample Number =11 }

Y —— ' -

0.1 1 10
Frequency (kHz2)

Figure 5.8 Human cochlear input impedance obtained by Aibara er al. 2000
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The estimated spring constant and damping coefficient as function of frequency are
plotted in Figures 5.9 (a) and (b). These results show that the spring constant and
damping coefficient are dependent on frequencies. In other words, we cannot estimate a
set of actural values for & and ¢ using the experimental cochlear input acoustic impedance
data. Therefore the previously published data for £ and ¢ cannot be adopted in our FE
model. In our FE model, the initial total stiffness of 49 springs was assumed as 60 N/m
and the initial total damping coefficient of 49 dashpots was taken to 0.054 N-s/m based
on the study of the simple model in Chapter 3. The final values for the two parameters
were determined by the model calibration process, described in the following section. We
will see that the final values determined by the model calibration process are the same as
the initial values.

When all these modeling considerations were incorporated, the initial FE model of

the middle ear was buiit.
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Figure 5.9 Spring constant and damping coefficient in one dimensional
mechanical model of cochlea derived from Aibara er al. 2000
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5.3 FE Model Parameter Determination

According to the discussions in Section 5.2, the mechanical properties of main
components of the middle ear have been assigned mainly based on the published data,
partially based on published experimental observations and partially based on the practice
of the simple model. These data are listed in Table 5.1. Most of the boundary conditions
also have been assumed based on the published data and the practice of the simple model.
There are only four model parameters that need to be determined. They are the Young’s
moduli of anterior mallear ligament and tympanic ring, as well as the stiffness and
damping coefficient of cochlear fluid. These four parameters were determined using the
FE model calibration process as described in Chapter 3.

The experimental measurements published by Gan er al, [ ¢ @ 200!

were used to
derive the four undetermined parameters following the FE model calibration process and
are exactly the same as those used for the simple model calibration. The measured mean
peak-to-peak displacement of the stapes footplate on seventeen normal fresh-frozen,
cadaveric temporal bones was employed to calibrate the FE model. To be consistent with
the experimental setup, a uniform pressure of 90 dB SPL (0.632 N/m’) was applied to the
lateral side of the eardrum in the initial FE model. The harmonic analysis was conducted
on the FE model across the frequency range of 250-8,000 Hz. The displacements of the
stapes footplate in the frequency field were collected and converted to peak-to-peak
displacement response of the stapes footplate. The objective of the calibration process is

to adjust the FE model prediction using the experimental curve obtained by the LDI

measurement as close as possible. Through the process, the model parameters related to
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the boundary conditions were finalized as listed in Table 5.3. The FE model with model

parameters listed in Tables 5.1 and 5.3 is called the base-line FE model of the middle ear.

Table 5.3 Boundary conditions used for the FE model

Young’s Modulus or Spring Constant Damping
Superior mallear ligament (C1) 4.9x10° N/m* (Beer ot a/. 1996) a=0s",3=0.0001 s
Lateral mallear ligament (C2) 6.7x10° N/'m® (Beer ot al. 1996)
Posterior incudal ligament (C3) | 6.5x10° N/m* (Wada et a/. 1996,
Prendergast et al. 1999, Ferris et al. 2000)
Anterior mallear ligament (C4) 2.1x10° N/m* (Determined by FE model calibration process)

Posterior stapedial muscie (C5) | 5.2x10° N/m* (Wada et al. 1996,
Prendergast et al. 1999, Ferris et al. 2000)

[ Tensor tympani muscle (C7) 2.6x10° Nim® (Wada et al. 1996, Prendergast et al. 1999)

Cochlear fiuid (C6) 60 N/m (Determined by FE model calibration process) 0.054 N-s/m
| Stapedius annular ligament 9 N/m (Converted from Lynch et al. 1982) 0 N-s/m
Tympanic ring 6.0x10° Nim* (Determined by FE model calibration process) | a=0 s’ $=0.0001s

The displacement magnitude at the stapes footplate obtained using the base-line FE
model was plotted together with the seventeen experimental curves in Figure 5.10. The

figure shows that the model-predicted stapes displacement curve falls between the

——Each of Gan et &/ 's Measurements 7 ;
~==Mean of Gan et &'s Measurements T

Peak-Peak Stapes Footplate Displacement
{(micron)

=== EA Prediction
G 0000t o000
Frequency (H2)

Figure 5.10 Comparison of stapes footplate displacements
between prediction and Gan et al. experimental measurements (2001)
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maximum and minimum of the 17 experimental curves. The predicted curve is lower than
the mean experimental curve, especially in the frequency range of 700~2,000 Hz. There
is a 1.92-fold difference in average between them. However, the trend is similar to the
mean curve obtained experimentally across the frequency range of 250-8,000 Hz. The
difference may come from the significant variations of individual temporal bones. The

possible reasons to produce the difference will be discussed in section 5.4.
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5.4 FE Model Verifications

In order to verify the accuracy of the base-line FE model, four independent
experimental results were employed. These experimental data include: (1) the magnitude
of the umbo displacement as a function of frequency measured by Nishihara er al. ™Vehher
eral 196 (2) the stapes velocity transfer function published by Aibara er al, 1A ol 20001
(3) the ratio of the umbo displacement to that of the stapes footplate converted from the

l [Nishihara er al. 1993

measurements of Nishihara et a , and (4) the ratio of the umbo

displacement to that of the malleus short process converted from the measurements of

Goode et al [Goode er al. 1994]

5.4.1 Comparison Of Frequency Response Of The Umbo Displacement

The experimental data from 64 normal ears were selected for the comparison. The
data are part of the experimental results published by Nishihara er g/, (Nishihara er al. 19|
their work, 99 ears of fifty-two human subjects (age 14 to 88 years, 31 males and 21
females) were used. In experiments, a small piece of reflective tape was placed on
subject’s umbo to serve as a laser-reflective target. When each of the thirty-four pure tone
sounds of 80 dB SPL were delivered to the eardrum, the umbo displacement induced by
the sound pressure on the eardrum was measured across the frequency range of 195-
19,433 Hz. The measurements were performed using a laser Doppler interterometer by
focusing the laser beam on the target placed at the umbo. The measured peak-to-peak
displacements at the umbo on the sixty-four ears were employed to verify the base-line

model.
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To be consistent with the experimental setup, a uniform harmonic pressure stimulus
of 80 dB SPL (0.2 N/m’) at the lateral side of the eardrum was applied to the FE model.
The harmonic analysis was conducted on the base-line FE model across the frequency
range of 250-8,000 Hz. The umbo displacements in frequency field were collected and
converted to peak-to-peak displacement response curve. The curve was plotted together
with the mean and the upper and lower bounds of the sixty-four experimental curves, as
shown in Figure 5.11. The comparison shows that the model-predicted umbo
displacements are within the bounds of the sixty-four experimental curves across the
frequency range of 250-8,000 Hz. It is noticed that the FEA prediction is close to the
lower bound of the experimental results, which is consistent to the case of the stapes

footplate displacement in comparison with Gan et al.’s results.

10
3 ~—— Upper Bound of Nishihara et al.'s 64 Normal Ears
g Low er Bound of Nishihara et al.'s 64 Normal Ears
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Figure 5.11 Comparison of umbo displacement between FEA prediction
and Nishihara et al. experimental measurements (1996)
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5.4.2 Comparison Of Human Middle Ear Sound Transfer Function

The ratio of the footplate velocity to the pressure at ear canal is termed as the ear
canal sound pressure to the stapes footplate velocity transfer function (STF). In this
comparison, the STF curves reported by Aibara er al. were employed to verify our base-
line mode] [Aibar er al. 20001 Tpe experimental measurements were conducted on twelve
normal fresh temporal bones (age 36-81 years, 9 males and 3 females). When a pure tone
sound of 90~120 dB SPL was delivered to the eardrum, the stapes footplate velocities
caused by the sound pressure on the eardrum was measured across the frequency range of
50-10,000 Hz. The measurements were performed using a laser Doppler interferometer
by aiming the laser beam on a small reflective tape on the center of the stapes footplate.
Sound pressure in the ear canal was measured near the eardrum using a probe-tube
microphone. The STF’s were calculated based on the measurements.

Because of the linear characteristics of the FE model, the ratio of the stapes footplate
velocity to the pressure at ear canal does not depend on the magnitude of the sound
pressure applied to the eardrum. Therefore, a uniform pressure of 90 dB SPL (0.632
N/m’) on the lateral side of the eardrum was applied to the base-line model. A harmonic
analysis was conducted on the base-line model across the frequency range of 250-8,000
Hz. The stapes footplate velocities in the frequency field were collected and converted to
the STF, which was plotted together with the mean and the upper and lower bounds of
the eleven experimental curves, as shown in Figure 5.12. This figure shows that the
model-predicted STF curve lies close to the lower bound of the experimental curves.

Again, it is consistent to previous observations.
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Figure 5.12 Comparison of STF between FEA prediction
and Aibara er al. experimental measurements (2000)

5.4.3 Comparison Of The Ratio Of Umbo To Stapes Footplate Displacements

The ratio of the umbo displacement to the stapes footplate displacement reflects the
effectiveness of the middle ear system in coupling sound pressure into the inner ear. For
FE model, the ratio may not be within a reasonable range even though both the stapes
footplate displacement and the umbo displacement are within the reasonable ranges.
Therefore, it is meaningful to test the base-line model by comparing the ratio between
experimental measurements and FE model prediction. The experimental data for the
comparison were calculated from Nishihara er al. measurements MVistihar ef al. 1993] e
experimental setup is similar to that described in Section 5.4.1. When a pure tone sound
of 80 dB SPL was delivered to the eardrum, the displacements of the stapes footplate and

the umbo caused by the sound pressure on the eardrum were measured using a laser

Doppler interferometer. The results are plotted in Figure 5.13. The FE model prediction
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Figure 5.13 Mean peak-to-peak displacement obtained by Nishihara et al. 1993
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Figure 5.14 Comparison of ratio of umbo displacement to stapes footplate displacement
between FEA prediction and Nishihara et al. measurements (1993)
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was calculated from the harmonic analysis results on the FE model under a uniform
sound pressure of 80 dB SPL. Figure 5.14 shows that the FEA prediction is, in general,

consistent with the experimental result.

5.4.4 Comparison Of The Ratio Of Umbo To Malleus Shortprocess
Displacements

The ratio of the umbo displacement to the malleus shortprocess displacement reflects
the vibration pattern of the malleus that affects the sound transmission in the ossicular
chain. Therefore, it is meaningful to test the FE model by comparing the ratio between
experimental measurements and FE model prediction. The experimental data for the
comparison was calculated from Goode er al.’s measurements (9% ¢ <l 199 The
experimental setup is similar to that of Section 5.4.1. When a pure tone sound of 94 dB
SPL was delivered to the eardrum, the displacements of the shortprocess and the umbo
caused by the sound pressure on the eardrum were measured using a laser Doppler
interferometer. The results are plotted in Figure 5.15. The FE model prediction was
calculated from the harmonic analysis results on the FE model under a uniform sound
pressure stimulus of 94 dB SPL. Figure 5.16 shows that the FEA prediction is close to the
experimental result in most range of frequency when the frequency is greater than 1,000
Hz. However, the prediction is lower than the experimental result in lower frequency
range. This experimental result indicates an unstable sound transmission effect from the
eardrum to the shortprocess in the entire frequency range, i.e., lower in low frequency
and higher in high frequency. The unstable sound transmission is not shown in FE model

prediction probably because we used the uniform Young’s modulus but non-uniform
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Figure 5.16 Comparison of ratio of umbo displacement to shortprocess displacement
between FEA prediction and Goode et al. measurements (1994)



density in malleus in the base-line FE model. The inconsistency of Young’s modulus and

the density may affect the transmission characteristics in low frequencies.

As discussed above, the verifications of the base-line FE model include four
experimental measurements, the umbo displacement, the stapes footplate velocity transfer
function, the ratio of the umbo displacement to the stapes footplate displacement and the
ratio of the umbo displacement to the malleus short process displacement. The results
were measured at three reference points, the umbo, the stapes footplate and the malleus
shortprocess. These verifications plus the comparison of the stapes footplate
displacements between FEA prediction and Gan et al’s experimental measurements
show that the base-line FE model predictions, in general, match the experimental results.
It is also noticed that the predictions for the stapes footplate displacement. the umbo
displacement and the stapes velocity transfer function are consistently lower than the
corresponding mean experimental measurements, especially in the frequency range of
700-2,000 Hz. The difference may be explained as follows:

(1) The individual difference in geometry and material properties induced the difference
between the predictions and the experimental results since the base-line model was
only based on one temporal bone and one set of mechanical properties. It has been
stated that the anatomical and physiologic individual differences of the external and
middle ear can induce up to 25 dB individual variation in hearing thresholds,
particularly in the frequency range of 1,000~4,000 Hz [Daflos 1973: Fieischer 1978: Goode. Gyo er
al. 1986. Goode 1986]

(2) Some of the material properties adopted in the base-line model were assumed or

determined by the calibration process, which may not be the actual values.



)

4)

()

(6)

The ear canal was not included in the FE model. It has been reported that the ear
canal acts as a pipe resonator that boosts hearing sensitivity in the range of 2,000-
5,000 Hz (Rossine 1990]

The action of the cochlear fluid was linearlized in the FE model. It is not the case in
reality, as discussed in Section 5.2.2.

The uniform Young’s modulus and non-uniform density were employed in the
ossicles in the base-line model. It is not the case in reality. The inconsistency of
Young’s modulus and the mass density may affect the transmission characteristics in
low frequency.

The sound pressure at the eardrum was simplified as uniform pressure load. In
reality, the load is non-uniform due to the particular shapes of the eardrum and the
| [Stinson 1985]

€ar cana

Although there are some differences between the base-line model predictions and

experimental data, we can still conclude that the base-line model is useful for predicting

the dynamic behaviors of the middle ear. It is appropriate to use the base-line model to

simulate the middle ear frequency response characteristics, which are the major concern

in the middle ear sound transmission study.
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CHAPTER SIX

APPLICATIONS OF THE BASE-LINE FE MODEL

In this chapter, the base-line FE model will be employed to investigate the dynamic
characteristics of human middle ear and support the otologic studies. The investigation
includes the dynamic characteristics of normal and altered ears. The otologic applications
focused on predicting the dynamic behaviors of the middle ear under various otologic

situations.

6.1 Rocking Of The Footplate

In this study, five points along the long and short axes of the stapes footplate were
selected to characterize the movements of the footplate, as shown in Figure 6.1. For
convenience, the direction normal to the footplate plane was defined as the piston
direction. The piston-like movement of the footplate was characterized using the piston-
directional displacement of the center point. The rotational movements of the footplate
were characterized by two rocking angles: anterior-posterior rocking angle (RA,.;) and
superior-inferior rocking angle (RA,.i), as well as two relative rocking angles: relative
anterior-posterior rocking angle (RRA,,) and relative superior-inferior rocking angle

(RRA;.). These rocking angles are defined as:

- - 6.1
dp), RA. :(an(u) ( )

=i

d{l
RA,_, = tan(

fong short



R4 R4, 62)

where d,.d,.d,,d,,and d, represent the piston-directional displacement at the anterior,
posterior, superior, inferior and central point of the footplate respectively; and /,,,. ./,

represent the length of the long and short axes of the footplate respectively. The rocking
angles provided a way to understand how the footplate rocks. The relative rocking angles
allowed us to observe the levels of the rotational movements of the footplate in anterior-

posterior plane and inferior-superior plane relative to the piston-like movement.

Superior Point \

Inferior Point

Posterior Point

Figure 6.1 Measure points at the stapes footplate

In order to obtain the FE model predictions of these angles in the frequency range of
250-8,000 Hz, the harmonic analysis was conducted using the base-line FE model with a
uniform stimulus of 90 dB SPL sound pressures applied on the lateral side of the
eardrum. The displacements of the five points were recorded to calculate these angles.
Figure 6.2 shows that the anterior-posterior and superior-inferior rocking angles have

patterns similar to Prendergast et al.’s calculations, as shown in Figure 6.3, although their
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Figure 6.3 Rocking angles as function of frequency calculated
by Prendergast, Ferris et al. 1999
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curves have more fluctuations [Prenderest. Fertiseral. 1999 pioure 6.4 indicates that the level of
anterior-posterior rocking movement increases with rising frequency but the level of
superior-inferior rocking movement reverses. The observation that the level of anterior-
posterior rocking movement increases with rising frequency is consistent with Heiland er
al.’s experimental conclusion !¢l ¢ @t 1991 Between 250-1,000 Hz, the predominant
movement is piston-like plus superior-inferior rocking. However, with increasing

frequency, the stapes displays increasing anterior-posterior rocking motions.
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Figure 6.4 Relative rocking angles as function of frequency

As Heiland er al. suggested, the studies might have important clinical implications
[Helland et al. 1999] [ the assumption holds, that is, the piston-like motion of the stapes is the
most effective in stimulating the cochlear fluid in vibrations of the stapes, any surgical

alteration on the middle ear may increase the non-piston-like motion of the stapes at



certain frequencies. As a result, a patient may experience poor post-surgical hearing
thresholds at these frequencies. Therefore, it is possible to aid surgical plans by FE
analysis on the vibration modes of the stapes before any surgical alteration, for example,
the ossicular replacement prosthesis. The behaviors of normal middle ear should always

be set as a goal for designing middle ear prosthesis.



6.2 Mass Loading On The Ossicles

The middle ear as a sound transmission system is affected by the mass changes in the
ossicular chain. An additional mass loading is detrimental to middle ear function (B¢ %
1997: Gan er al. 20011 Therefore, it is helpful for bioengineers to determine the effect of the
mass of implants on stapes footplate movement before designing a new implantable
device.

In this study, the middle ear base-line FE model was used to predict the variations of
the footplate displacement due to different implants. As shown in Figure 6.5, the implant

was modeled as a mass block of prescribed mass density using solid elements. The mass

.Eii‘ésament

Figure 6.5 FE model of human middle ear with mass block
on incudostapedial joint
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block was placed onto the incudostapedial joint to simulate the implant mass loading of a
passive middle ear device, such as the SOUNDTEC ™ Direct System or the Symphonix
™ Vibrant. Two experimental middle ear implants A and B (weighing 22.5 and 37.5 mg)
were used for this study. These two implants were in cylindrical configuration. Both
implants were 1.5 mm in diameter, but the implant A was 1 mm shorter than the implant
B (3 mm long).

To obtain the displacements of the stapes footplate from the middle ear base-line FE
model with two different implants, the harmonic analyses were conducted. Then, the
difference of the stapes footplate displacements for the two implants were calculated in

dB using the following equation:

8dB = 20log(d ,/d,,, ) - 20log(d ,/d,, ) = 20log(d ,/d ;) (6.3)

where d, and d, are the stapes footplate displacements calculated from the base-line FE
model with implant A and implant B on the incudostapedial joint, respectively; and d,r is
the reference displacement. Therefore 3dB is the displacement difference in dB of the
two situations. It also indicates how large the displacement improvement can be obtained
when the implant mass is reduced.

Using Eq.(6.3) we calculated the variation of footplate displacements in dB due to
change of the mass loadings. It is found that 22.5 mg mass loading, compared to the 37.5
mg mass loading, results in an average 3 dB improvement across the frequency range of
250-8,000 Hz. The result was plotted in Figure 6.6 with the broken line. For comparison,
the result of an experimental study was plotted with the solid line in the same figure (#"¢
al. 20011 The experimental data show that there is no change in displacement due to the

mass reduction at the low frequencies (<1000 Hz). But an obvious improvement at high



frequencies (>3000 Hz) was observed due to the 15 mg (=37.5-22.5) mass reduction. The
base-line model prediction also shows an improvement at high frequencies (>3000 Hz)

similar to the experimental data.

- = — - FEA Prediction
Measurement

Stapes Footplate Displacement increase in dB

o 1000 10000
Frequency (HZ)

Figure 6.6 Stapes footplate displacement increase due to a 15 mg
mass loading reduction on incudostapedial joint
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6.3 Change Of The Eardrum Stiffness

In this study, the influence of eardrum stiffness on stapes footplate displacements
was examined using the base-line FE model. The harmonic analyses were conducted
using the base-line model under uniform pressure stimuli of 90 dB SPL at the lateral side
of the eardrum. The displacements of the stapes footplate for different stiffness of the
eardrum pars tensa were collected and plotted in Figure 6.7. In this figure, the solid line
represents the normal eardrum, having circumferential Young’s modulus of 2.0x10” N/m’
and radial modulus of 3.2x10" N/m’. The dotted line and broken line represent
respectively the increment and decrement of the eardrum Young’s moduli by a factor of
10. The change was applied to both circumferential and radial values. As shown in Figure
6.7, the stiffness of the eardrum affects the frequency response of the stapes footplate
displacement. An increased stiffness (Young’s modulus higher than normal) of the
eardrum results in reduced stapes displacements at low frequencies (<1250 Hz) and
increased displacements at high frequencies (21250 Hz). A decreased stiffness of the
eardrum results in reduced stapes displacements in a large frequency range (2350 Hz)
and a reverse result in a small frequency range (<350 Hz). These results agree with the
predicted effects of the eardrum stiffness on the transmission factor of the middle ear by
Koike er al. [Koke ¢ ab 20001 The transmission factor was defined as the ratio of the
intracochlear pressure to the stimulus pressure in front of the eardrum, which has the
similar meaning to the footplate displacement in responding to the input sound pressure
level at the eardrum. This suggests that an eardrum-stiffness-related hearing loss can be
studied using the base-line model. For this purpose, we have to determine what cause the

increase or decrease of the eardrum stiffness.
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Figure 6.7 Effect of the eardrum stiffness on stapes footplate displacement

These preliminary clinical applications of the base-line model predicted rocking of
the footplate, the effects of passive implant mass loading on the ossicles and changes in
the eardrum stiffness on middle ear system function. The results suggest that the base-line
model is useful in the study of middle ear mechanics and the design of implantable
hearing devices. Perforations of the eardrum, otosclerosis, and both passive and active
functions of implantable hearing devices may extend the utility of this base-line FE
model. In a word, the base-line FE model can provide a convenient, fast and economic
way to predict the consequences of diseases and surgeries. It also can be used to support
the design of implants and prostheses in selecting materials, configurations and other
design parameters. Especially, the base-line FE model can be employed to optimize the
positions and orientations of implants and prostheses in the ear by comparing different

surgical plans.
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CHAPTER SEVEN

CONCLUSIONS AND RECOMMENDATIONS

7.1 Conclusions

The research work presented in this dissertation involves the development of a
computer-aided geometric modeling method for constructing human middle ear solid
models from histological sections of human temporal bone, a computer-integrated finite
element modeling method that converts the solid model to the analysis model for human
middle ear mechanics, and the preliminary clinical applications of the FE model. The
approach provides a tool for physicians and bioengineers to investigate 3D morphometry
and dynamic behaviors of human middle ear from 2D histological sections of temporal
bones. The outcome is a 3D base-line FE model of human middle ear with accurate
geometric representation and relevant clinical applications of the model.

The outcome proves all the hypotheses formulated for the research in Chapter 1.
First, the results of Chapters 5 and 6 prove that FEM can be used to appropriately predict
the dynamic behaviors of normal, diseased, and altered human middle ears. Second, the
results of Chapter 4 prove that an accurate and systematic geometric modeling method
can be developed to support the human middle ear FE modeling. Third, the results of
Chapters 3 and 5 prove that the FE middle ear models can be successfully calibrated

using experimental results to simulate the behaviors of normal ears. Fourth, the results of
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Chapter 6 prove that some clinical applications can be characterized by identifying and
quantifying FE model parameters.

The outcome also indicates the achievement of all objectives in the research. The
major contributions of this research are:

(1) A systematic computer-aided geometric modeling method for constructing accurate
human middle ear solid models in computer.

(2) A computer-integrated finite element modeling procedure for the human middle ear.

(3) A thorough review on the mechanical properties of human middle ear.

(4) An experimentally verified base-line FE model of human middle ear.

(5) Three successful applications of the base-line FE model for investigating the
dynamic behaviors of normal and altered human middle ears.

The computer-aided geometric modeling method was developed to accurately
reconstruct the geometry of human middle ear. The accurate geometry is essential for
realistic middle ear dynamic analysis. The method begins with the histological section
slide preparation of human temporal bone. The section slides are scanned into computer
and calibrated into standard section images. The section images are then digitized to
construct the geometry of human middle ear using the curve fitting and surface skinning
techniques and CAD tool. This method is accurate, systematic, general and low cost. By
employing the histological sections of human temporal bone, the accurate details of the
structure are captured. By the systematic imaging process, the mismatch of component
contours due to inevitable operation errors is minimized. By the error control scheme
implemented in the curve fitting for image contours, the reconstructed geometry can be

close to the real middle ear structure within a prescribed error bound. The standardized
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procedure makes the method easy to follow and eliminates potential inconsistency and
mistakes. The fewer requirements for laboratory instruments and computer software tools
make the method cost effective. Most importantly, it is applicable to structures with
complicate geometry, various topology, and different physical sizes. This method works
especially well with small-size structure and complicate geometry like human middle ear.
The solid geometric model of human middle ear has been proven to be a good basis for
fabricating the physical model and building the FE model of human middle ear.

The computer-integrated FE modeling method was developed to predict the dynamic
behaviors of the middle ear. The method begins with the generation of finite element
meshes of human middle ear. The anatomic characteristics and functions of the middle
ear are incorporated in to the FE model by assigning different material properties to
different parts of the middle ear system. Most material properties are selected based on a
thorough investigation about the mechanical properties of the middle ear. The remaining
material properties are assumed partially through engineering reasoning and partially by
the FE model calibration process. By perturbing model parameters in a restrictive
manner, the FE model is calibrated to match the FE model prediction with the laser
Doppler interferometry measurements of the stapes footplate displacement. The
procedure produces the base-line FE model of human middle ear.

The base-line model is verified by using four independent experimental
measurements. The verifications test three points, the umbo, the stapes footplate and the
malleus shortprocess, of the FE model using these measurements. The verifications show
that the FE model predictions match the experimental results well. Therefore, we believe

that the base-line FE model is very useful for predicting the dynamic behaviors of the
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middle ear. It is appropriate to investigate the middle ear frequency response
characteristics using the base-line model, which are the major concern of the middle ear
sound transmission study.

The detailed review about the mechanical properties of the middle ear is crucial for
building and finalizing the FE model. It will also benefit future research related to middle
ear mechanics.

Movement of the stapes footplate generally represents the mechanical output of the
middle ear in response to sound input at the eardrum. In the application studies, the
displacement of the stapes footplate was selected as the primary variable. The clinical
applications of the base-line model predicted the rocking of the normal ear, the effects of
passive implant mass loading on ossicles, and the effects of eardrum stiffness variation on
the middle ear system function. The results suggest that the finite element model is useful
in the study of middle ear mechanics and the design of implantable hearing devices.
Perforations of the eardrum, otosclerosis, and both passive and active functions of

implantable hearing devices may extend the usage of the base-line FE model.
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7.2 Recommendations

The purpose of the section is to discuss additional research issues that ought to be
explored to advance our understanding on the middle ear mechanics. There are several

areas in which the current research may be expanded.

7.2.1 Finite Element Model Of The Middle Ear

The efficacy of the base-line FE model can be further improved by adding more ear
components related to sound transmission into the model. These components include the
external ear canal, the middle ear cavity and the cochlea. Adding these components will
simulate the real sound transmission process from the external ear to the inner ear by the
ossicular chain. The ear canal and middle ear cavity can be modeled using acoustic
elements to form the real sound pressure distribution on the eardrum and the real
vibration environment for the middle ear. The cochlea can be modeled using fluid
elements that will effectively realize the real cochlear input impedance. In the model, an
additional boundary will be applied at the Eustachian tube, and the sound pressure can be
applied at the open end of the ear canal. The new FE model, once developed, will be
suitable to predict the sound transmission characteristics for the entire ear including
outer, middle and inner ears. It also provides a possibility to investigate the effect of the
perforation of the eardrum and the injury of the ear due to violent environmental factors

such as blasts, abrupt environmental pressure change, intense noise, etc.

7.2.2 Multibody Model Of The Middle Ear

The multibody dynamic analysis of human middle car scrves as one of the theoretical
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bases of the artificial ear. To prepare for the multibody analysis of the middle ear, the
mass properties of the ossicles, including the mass, the center of mass and the moments
of inertia, can be calculated easily based on the CAD model of the middle ear using
SolidWorks. The multibody model is also suitable to explore the dynamic behaviors of

the incudomalleolar and incudostapedial joints.

7.2.3 Material Property Test Of The Ear System

In FE modeling of human middle ear, the most difficult task is to find the real
mechanical properties of the middle ear system. Unfortunately, there is still lack of
experimental data for a complete set of material properties. In the base-line FE model,
some mechanical properties came from estimates. The base-line FE model was finalized
by the FE model calibration process that yields the best estimates of the mechanical
properties. We need more accurate mechanical property data for better models that will

produce more accurate predictions.

7.2.4 Identifications Of The Mechanical Parameters Related To Clinical
Situations

For successful clinical applications using the FE model, the relations between the FE
model parameters and the clinical situations, such as diseases and aging, must be first
identified. Once the work is completed, the FE model can be used to explore various
clinical situations in computer using the variations of the model parameters as input. It is
a fast and less expensive way to understand how various diseases affect the middle ear
function. The implementation of the work will require more collaboration between

bioengineers and physicians.
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